Document History

The following table provides an overview of the most important document changes.

Table 1

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>2017-05-10</td>
<td>Initial Version</td>
</tr>
</tbody>
</table>

© Copyright 2016 SAP SE or an SAP affiliate company.
All rights reserved.
## Content

1. **Getting Started** .............................................................. 5
2. **SAP S/4HANA System Landscape Information** ...................................... 6
3. **Monitoring** .................................................................. 8
   3.1 Alert Monitoring with CCMS ...................................................... 8
   3.2 Trace and Log Files ........................................................... 8
   3.3 Process Monitors ............................................................. 8
4. **Management of SAP S/4HANA** ................................................ 10
   4.1 Starting and Stopping .......................................................... 10
   4.2 Software Configuration ....................................................... 10
   4.3 Output Management ......................................................... 10
   4.4 Backup and Recovery ......................................................... 12
   4.5 Load Balancing ............................................................... 13
   4.6 Data Archiving and Data Aging ............................................. 13
5. **User Management** ........................................................... 14
6. **Business Continuity and High Availability** ........................................ 15
7. **Software Logistics and Change Management** ...................................... 16
   7.1 Change and Transport Management ....................................... 16
   7.2 Support Package and Patch Implementation ................................ 16
   7.3 Release and Upgrade Management .......................................... 17
8. **Troubleshooting** ............................................................... 18
9. **Support Desk Management** ................................................... 19
10. **SAP S/4HANA Enterprise Management** ........................................... 20
    10.1 Finance .......................................................... 20
    10.2 Manufacturing ...................................................... 21
    10.3 Sales .......................................................... 25
    10.4 Sourcing and Procurement ................................................. 26
    10.5 Supply Chain .......................................................... 27
    10.1.1 Specific Monitoring Tools for Settlement Management ................. 20
    10.2.1 Production Planning ................................................. 21
    10.3.1 Specific Monitoring Tools for Sales Contract Management ............ 25
    10.4.1 Supplier Information and Master Data .................................... 26
    10.4.2 Specific Monitoring Information for Supplier Information and Master Data 26
    10.4.3 Scheduled Periodic Tasks ............................................. 27
    10.4.4 Specific Troubleshooting for Supplier Information and Master Data .... 27
    10.5.1 Efficient Logistics and Order Fulfillment .................................. 28
    10.5.2 Warehouse Management .............................................. 28
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.6</td>
<td>Enterprise Technology</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>SAP Application Interface Framework</td>
<td>40</td>
</tr>
<tr>
<td>10.7</td>
<td>R&amp;D / Engineering</td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>Product Lifecycle Management</td>
<td>49</td>
</tr>
<tr>
<td>11</td>
<td>SAP S/4HANA LoB Products</td>
<td>51</td>
</tr>
<tr>
<td>11.1</td>
<td>Asset Management</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>Environment, Health, and Safety</td>
<td>51</td>
</tr>
<tr>
<td>11.2</td>
<td>Cross Applications</td>
<td>62</td>
</tr>
<tr>
<td></td>
<td>Master Data Governance</td>
<td>62</td>
</tr>
<tr>
<td>11.3</td>
<td>Finance</td>
<td>20</td>
</tr>
<tr>
<td>12</td>
<td>SAP S/4HANA LoB Products for specific industries</td>
<td>66</td>
</tr>
<tr>
<td>13</td>
<td>SAP S/4HANA Compatibility Packs</td>
<td>67</td>
</tr>
<tr>
<td>13.1</td>
<td>R&amp;D / Engineering</td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>Product Safety and Stewardship</td>
<td>67</td>
</tr>
<tr>
<td>14</td>
<td>Business Network Integration</td>
<td>88</td>
</tr>
<tr>
<td>14.1</td>
<td>Monitoring Business Network Integration: Overview</td>
<td>88</td>
</tr>
<tr>
<td></td>
<td>Monitoring of cXML Messages</td>
<td>88</td>
</tr>
<tr>
<td></td>
<td>Application Log</td>
<td>90</td>
</tr>
<tr>
<td></td>
<td>Forward Error Handling</td>
<td>91</td>
</tr>
</tbody>
</table>
1 Getting Started

Recommendation
This guide does not replace the daily operations handbook that we recommend you to create for your specific production operations.

About This Guide

This guide provides a starting point for managing your SAP applications and maintaining and running them optimally. It contains specific information for various tasks and lists the tools that you can use to implement them. This guide also provides references to the documentation required for these tasks, so you will also need to refer to other documentation, especially to the documentation Technical Operations for SAP NetWeaver at the SAP Help Portal under help.sap.com/s4hana_op_1610_002 SAP NetWeaver for SAP S/4HANA.

Note
You always find the most up-to-date version of this guide at the SAP Help Portal under help.sap.com/s4hana_op_1610_002.

The first section of the guide contains generic information, valid for the entire on-premise edition of SAP S/4HANA. The sections starting with SAP S/4HANA Enterprise Management contain information for specific functional areas.
2 SAP S/4HANA System Landscape Information

There are various ways of deploying SAP S/4HANA in your new or already existing system landscape. This section describes some examples.

Example: SAP S/4HANA New Installation

A new installation of SAP S/4HANA needs to run on the SAP HANA database. It also requires the SAP Solution Manager, which can run on any database. This very simple landscape can be enhanced with the SAP cloud solutions and SAP Business Suite products.

Example: SAP S/4HANA in an SAP Business Suite Landscape

It is possible to integrate SAP S/4HANA into an existing SAP Business Suite landscape by replacing the SAP ERP enhancement package product with SAP S/4HANA. When performing this conversion in your system landscape, you need to do some adaptations, for example you need to convert your existing business processes to the simplified SAP S/4HANA processes. Some of the SAP Business Suite processes are no longer supported, some have been changed and there are also new processes. How to convert your existing processes to the SAP S/4HANA processes is described in the Simplification List.
For more information about the Simplification List, see the Conversion Guide for SAP S/4HANA at help.sap.com/s4hana_op_1610_002 Product Documentation.

**Figure 2:** Example SAP Business Suite landscape with an embedded SAP S/4HANA system

### More Information

For more information about SAP Fiori for SAP S/4HANA in a hub deployment, see Landscape Deployment Recommendations for SAP Fiori Front-End Server.
3 Monitoring

SAP provides you with an infrastructure to help your technical support consultants and system administrators effectively monitor your system landscape.


For more information about monitoring with SAP Solution Manager, see the SAP Help Portal under help.sap.com/s4hana_op_1610_002 ➤ SAP NetWeaver for SAP S/4HANA ➤ Technical Operations for SAP NetWeaver ➤ Solution Life Cycle Management ➤ Connecting a Technical System to SAP Solution Manager ➤.

3.1 Alert Monitoring with CCMS

SAP S/4HANA uses the standard SAP NetWeaver monitoring tools, including the Computing Center Management System (CCMS). The tool allows you to monitor your system landscape centrally.

Alerts form a central element of monitoring. They quickly and reliably report errors (such as values exceeding or falling below a particular threshold value or that an IT component has been inactive for a defined period of time). These alerts are displayed in the Alert Monitor of the CCMS.

You can also monitor your data archiving activities with the monitoring functions provided by the CCMS.

For more information about CCMS, the Alert Monitor, and monitoring of data archiving, see the SAP Help Portal under help.sap.com/s4hana_op_1610_002 ➤ SAP NetWeaver for SAP S/4HANA ➤ Function-Oriented View ➤ Solution Life Cycle Management ➤ Solution Monitoring ➤ Monitoring in the CCMS ➤.

For more information about how to enable the auto-alert function of CCMS, see SAP Note 617547 ➤.

For more information about data archiving, see Data Archiving and Data Aging [page 13].

3.2 Trace and Log Files

Trace and log files are essential for analyzing problems. SAP S/4HANA uses the standard SAP NetWeaver tools for tracing and logging.

For more information about this topic, see the SAP Help Portal under help.sap.com/s4hana_op_1610_002 ➤ SAP NetWeaver for SAP S/4HANA ➤ Technical Operations for SAP NetWeaver ➤ Solution Life Cycle Management ➤ Application Log (BC-SRV-BAL) ➤.

3.3 Process Monitors

SAP S/4HANA uses the standard SAP NetWeaver process monitoring tools.
For more information, see the SAP Help Portal under help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ Solution Life Cycle Management ➔ Solution Monitoring ➔ Process Monitoring with PMI (Process Monitoring Infrastructure) ➔
4  Management of SAP S/4HANA

SAP provides you with an infrastructure to help your technical support consultants and system administrators effectively manage all SAP components and complete all tasks related to technical administration and operation. For more information about operational topics, see Technical Operations for SAP NetWeaver at the SAP Help Portal under help.sap.com/s4hana_op_1610_002 SAP NetWeaver for SAP S/4HANA.

4.1  Starting and Stopping

You use the SAP Management Console to stop and start SAP systems based on SAP NetWeaver, including SAP S/4HANA.

For more information on the SAP Management Console, see the SAP Help Portal under help.sap.com/s4hana_op_1610_002 SAP NetWeaver for SAP S/4HANA Technical Operations for SAP NetWeaver Solution Life Cycle Management Starting and Stopping SAP NetWeaver AS for ABAP and Java.

4.2  Software Configuration

For information about how to do the configuration for SAP S/4HANA, see the guide Getting Started With SAP S/4HANA at the SAP Help Portal under help.sap.com/s4hana_op_1610_002 Getting Started.

4.3  Output Management

SAP S/4HANA introduces a new style of output management. Note that other existing frameworks can be used as well, depending on the application.

You make settings for output control in Customizing under Cross-Application Components Output Control. This is an overview of the required technical setup.

Prerequisites for Output Control

- bgRFC configuration has been set up
- Storage system and category have been maintained
- BRFplus is active and usable
- Adobe Document Services is available (when using Adobe Forms)

bgRFC (Background Remote Function Call)

Output control uses a bgRFC to process output. Therefore, you need to maintain the bgRFC configuration. Otherwise, no output can be performed.
You can perform all the relevant steps in transaction SBGRFCCONF. One of the most important steps is defining a supervisor destination, as bgRFC doesn’t work without it.

For more information, enter the keyword bgRFC Configuration at help.sap.com, and refer to SAP Note 2309399 and SAP Note 1616303.

**Storage System and Category**

Output control needs a defined storage system (content repository) to save the rendered form output as PDF.

To set up the storage system, choose the following navigation option:

<table>
<thead>
<tr>
<th>Table 2</th>
<th>SAP Menu</th>
<th>Transaction Code</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SPRO &gt; Cross-Application Components &gt; Document Management &gt; General Data &gt; Settings for Storage Systems &gt; Maintain Storage System</td>
<td>/nOAC0</td>
</tr>
</tbody>
</table>

You can set up the storage type which fits your needs, for example a SAP System Database, or a HTTP content server (such as fileserver, database, or external archive).

Once the storage system is available, you need to assign it to the predelivered storage category SOMU. To do so, choose the following navigation option:

<table>
<thead>
<tr>
<th>Table 3</th>
<th>SAP Menu</th>
<th>Transaction Code</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SPRO &gt; Cross-Application Components &gt; Document Management &gt; General Data &gt; Settings for Storage Systems &gt; Maintain Storage Category</td>
<td>/nOACT</td>
</tr>
</tbody>
</table>

Select category SOMU. For column **Document Area**, choose SOMU. For column **Content Repository**, choose the content repository you created in the previous step.

**Business Rule Framework plus (BRFplus)**

Output control uses BRFplus for the output parameter determination. Technically, BRFplus is based on WebDynpro applications. Therefore, you need to set up the according ICF services:

<table>
<thead>
<tr>
<th>Table 4</th>
<th>Services</th>
</tr>
</thead>
<tbody>
<tr>
<td>/sap/bc/webdynpro/sap/ftd_wd_workbench</td>
<td>FDT Workbench</td>
</tr>
<tr>
<td>/sap/bc/webdynpro/sap/ftd_wd_object_manager</td>
<td>FDT Object Manager</td>
</tr>
<tr>
<td>/sap/bc/webdynpro/sap/ftd_wd_catalog_browser</td>
<td>FDT Catalog Browser</td>
</tr>
</tbody>
</table>

For more information, enter the keyword Active Services in SICF at help.sap.com.

Once you’ve set up the services, download and install the required BRFplus applications from SAP Note 2248229.

Procedure:

1. Access transaction BRF+.
   
   If required, personalize your screen, and change the user mode from Simple to Expert.


3. On the Business Rule Framework plus – XML Import screen, under File and Transport Request, browse for the local *.xml files you want to import. You can import the files one after the other.

4. In the Customizing Request field, enter an applicable Customizing Request ID.
5. Choose **Upload XML File**.
6. Choose **Back to Workbench**.

Adobe Document Services (ADS)

Applications in SAP S/4HANA ship default form templates implemented as PDF-based print forms with fragments.

They require ADS for rendering. ADS is available as cloud solution or on-premise solution.

The cloud solution is a service provided on the HANA Cloud Platform. See SAP Note [2219598](https://support.sap.com) for more information and links to the documentation for the new solution Form Service by Adobe.

For the on-premise solution, you need an AS Java installation (with `ADOBE` usage type) to run ADS.

ADS itself must have version 10.4 (1040.xxx) or higher. This version is delivered with NW 7.31 SP7 (and higher), NW 7.40 SP2 (and higher), and NW 7.50 (all SPs).

You do not necessarily need to use ADS, as output management also supports SAPscript and Smart Forms. However, special customizing is necessary for these two form technologies, and restrictions apply. For more information, see SAP Notes [2292539](https://support.sap.com) and [2294198](https://support.sap.com).

Printer Setup

Printing is done using the spool. For more information, see the *[SAP Printing Guide](https://help.sap.com)* at the SAP Help portal under `help.sap.com/s4hana` → `<choose a release>` → *SAP NetWeaver for SAP S/4HANA* → *Function-Oriented View* → *Solution Life Cycle Management*.

Output control uses the short name of the printer (for example `LP01`), as defined in transaction `SPAD`.

**Limitations**

- Printing using the spool is not available in release S4CORE 1.00 SP00. If this is the case, please upgrade to S4CORE 1.00 SP01.
- Currently, a PDF is always created for any kind of form.
  - This has the following impact:
    - Previewing the document from the spool request is only possible when the device type is `PDF1` or `PDFUC`.
    - Using another device type can lead to alignment issues for SAPscript and Smart Forms.
- Frontend output is not supported, since the output is processed via bgRFC.

**More Information**

SAP Note [2228611](https://support.sap.com)

**4.4 Backup and Recovery**

You need to back up your system landscape regularly to ensure that you can restore and recover it in case of failure.

To use an appropriate back up and restore method is one of the most important tasks of the system and database administrator. However, there is no general recommendation for such a method, since it depends on several factors, such as:

- Disaster recovery concept
- Maximum permissible downtime during restore
- Amount of data loss that can be tolerated
- Available budget

For more information about backup and recovery, see:


## 4.5 Load Balancing

SAP S/4HANA uses the standard SAP NetWeaver functions for load balancing.

For more information about this topic, see Technical Operations for SAP NetWeaver at the SAP Help Portal under help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔

## 4.6 Data Archiving and Data Aging

### Data Archiving

You can use the data archiving functions to archive any completed business transactions that are no longer relevant for your daily operations, and so significantly reduce the load on the database. SAP S/4HANA uses the functions for archiving provided by SAP NetWeaver.

For more information about data archiving, see the SAP Help Portal under help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔ Technical Operations for SAP NetWeaver ➔ Solution Life Cycle Management ➔

For more information about monitoring of data archiving, see Alert Monitoring with CCMS [page 8].

### Data Aging

Data aging offers you the option of moving large amounts of data within a database so as to gain more working memory.

You use the relevant SAP application to move data from the current area to the historical area. You control the move by specifying a data temperature for the data. The move influences the visibility when data is accessed. This means that you can perform queries of large amounts of data in a much shorter time.

For more information about data aging (including the prerequisites for enabling it), see the SAP Help Portal under help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔ Technical Operations for SAP NetWeaver ➔ Solution Life Cycle Management ➔.

For more information about specific SAP S/4HANA data aging objects, see Efficient Logistics and Order Fulfillment [page 28].
5  User Management

SAP S/4HANA generally relies on the user management and authentication mechanisms provided with the SAP NetWeaver platform, in particular the SAP NetWeaver ABAP Application Server, and the SAP HANA Platform. Therefore, the security recommendations and guidelines for user administration and authentication as described in the Security Guides for SAP NetWeaver and SAP HANA Platform also apply to SAP S/4HANA.

For more information, see:

  ❯ SAP NetWeaver for SAP S/4HANA ❯

In addition to these guidelines, we include information about user administration and authentication that specifically applies to SAP S/4HANA in the Security Guide for SAP S/4HANA at the SAP Help Portal under help.sap.com/s4hana_op_1610_002❯ Product Documentation ❯.
The term business continuity covers all activities performed by system administrators to ensure that critical business functions are available to system users. Strategies for high availability are a subset of business continuity activities, but business continuity is not limited to high availability. Other activities that relate to business continuity include:

- System backup and archiving
- System updates with minimum downtime

SAP S/4HANA uses the standard SAP NetWeaver functions for high availability and business continuity. For more information about these topics, see:

- Technical Operations for SAP NetWeaver at the SAP Help Portal under help.sap.com/s4hana_op_1610_002
  - SAP NetWeaver for SAP S/4HANA
  - System Administration
7 Software Logistics and Change Management

The tools and processes in Software Logistics help you to manage the system landscape in all lifecycle phases. Besides initial implementation of an application, the tools also support on-going system optimization and adaptation to evolving demands, as well as implementing additional functions.

Note
Some software logistics tools are delivered and regularly updated with the Software Logistics Toolset. For more information about these tools, see the documentation on the SAP Help Portal under help.sap.com/sltoolset.


7.1 Change and Transport Management

SAP S/4HANA uses the SAP NetWeaver tool Change and Transport System (CTS) to organize development projects in ABAP Workbench and customizing, and to then transport the changes between the SAP systems in your system landscape. In addition to ABAP objects, you can transport non-ABAP objects and non-SAP applications in your system landscape.

For more information about the CTS tool, see Technical Operations for SAP NetWeaver at the SAP Help Portal under help.sap.com/s4hana_op_1610_002 SAP NetWeaver for SAP S/4HANA.

7.2 Support Package and Patch Implementation

We recommend that you implement Support Package Stacks (SP stacks), which are sets of support packages and patches for a specific product version that must be used in a specific combination.

You can find detailed information about the availability of SP-Stacks for SAP S/4HANA at the SAP Support Portal under support.sap.com/sp-stacks. Check the corresponding Release and Information Notes (RIN) before you apply any support packages or patches of the selected SP-Stack. The RIN for SAP S/4HANA 1610 is SAP Note 2346431. See also the Support Package Levels for SAP S/4HANA in SAP Note 2236608.

For more information about the implementation of support packages, see information on the SAP Support Portal under support.sap.com/patches SAP Support Packages.
For more information about the tools for implementing patches, see also the SAP Help Portal under help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔ Technical Operations for SAP NetWeaver ➔ Solution Life Cycle Management ➔ Software Logistics ➔.

**Note**

Support package stack (SPS) is equivalent to feature package stack (FPS). The term **feature** indicates that new features are delivered with the FPS, not just bug fixes as with support package stacks.

### 7.3 Release and Upgrade Management

Corrections for SAP S/4HANA are available in support packages.
8 Troubleshooting

For more information about troubleshooting for SAP NetWeaver based systems, see the SAP Help Portal under help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔ Technical Operations for SAP NetWeaver ➔ Solution Life Cycle Management ➔
9 Support Desk Management

You can set up problem resolution procedures tailored to your requirements. The procedure should integrate your business users, internal support personnel, partners and SAP support.

Remote Support Setup

If you want to use SAP remote services (for example, SAP EarlyWatch or Remote Consulting), or if you would like to permit an SAP support consultant to work directly in your system to make a more precise problem diagnosis, then you need to set up a remote service connection.


Problem Message Handover

SAP S/4HANA uses the functions of the SAP Solution Manager to create internal support messages and to forward them to SAP.

For more information, see the SAP Help Portal under help.sap.com/solutionmanager/SAP Solution Manager 7.1 Application Help SAP Engagement and Service Delivery.

To send problem messages to SAP, use the relevant application component in the SAP application component hierarchy.
10 SAP S/4HANA Enterprise Management

This section of the Operations Guide for SAP S/4HANA contains specific operations information for the functionality included in SAP S/4HANA Enterprise Management.

10.1 Finance

This section of the Operations Guide for SAP S/4HANA contains information about operation tasks specific to Finance.

Archiving and Data Aging

Archiving

For information about archiving in Finance, see Enterprise Technology at the SAP Help Portal under help.sap.com/s4hana_op_1610_002 → Product Assistance.

Data Aging

To use Data Aging, proceed as follows:

1. Activate Data Aging by entering the profile parameter abap/data_aging in the database.
2. Activate the Data Aging business function DAAG_DATA_AGING using the switch framework (transaction SWF5).
3. Partition the database tables for aging (transaction DAGPTM).
4. Activate aging object FI_DOCUMENT.
5. Maintain the residence time in Customizing for data object FI_DOCUMENT according to company code, account types, and document types.

For more information, see also Data Archiving and Data Aging [page 13]

10.1.1 Specific Monitoring Tools for Settlement Management

This section of the Operations Guide for SAP S/4HANA contains information about monitoring tools specific to Settlement Management.

Condition Contract Management

In Settlement Management, you can create remuneration settlements by using the Post Processing Framework. Depending on the Customizing settings, remuneration settlements are created:
Automatically in a synchronous or an asynchronous way when a document is saved
Manually when the Selection and Processing of Actions report is run (transaction SPPFP)
The relevant Customizing settings are located in Customizing for Logistics - General under Settlement Management > Condition Contract Management > Condition Contract > Define and Configure Actions.
The processing status is tracked in the log of the Post Processing Framework.

Selecting Actions with Processing Errors
1. Go to transaction WCB_SPPFP.
2. Set the processing time to initial and then select action status 2.
   After execution, the system displays all actions with processing errors.
3. Use the processing log to analyze the cause of the errors.
   To select actions that have not been processed yet, select action status 0. By adding the creation date as an additional search parameter, you can find successful actions that have not been processed for a long period of time.

10.2 Manufacturing

This section of the Operations Guide for SAP S/4HANA contains information on operations tasks specific to Manufacturing.

10.2.1 Production Planning

This section contains information for Production Planning valid for Material Requirements Planning.

10.2.1.1 Material Requirements Planning

This section describes specific operational details that are valid for Material Requirements Planning.

Report for Processing MRP Records

You use the report PPH_SETUP_MRPRECORDS to create and correct MRP records for a given set of plants. It reads material master data such as the MRP type and creates a corresponding MRP record.
You can use this report to create MRP records that are to be used for operative planning. If you want to create MRP records to be used for simulative planning (long-term planning), a second report is available: PPH_SETUP_MRPRECORDS_SIMU.
Prerequisites

The materials in the plant must be relevant for MRP. That is, you must have maintained the MRP views in the material master records of the materials and have set a suitable MRP type.

Features

By selecting the Regenerative (w. BOM Explosion) checkbox, you can start the report in regenerative mode meaning that the system automatically sets the net change flag and the BOM explosion flag for each material. Alternatively, you can use the report as a consistency check to update the MRP records - in this case you do not set the Regenerative (w. BOM Explosion) checkbox.

Clean Up Total Requirements

Before you can carry out the planning run using MRP Live, you have to make sure that you have no total requirements in your system. Proceed as described below to deal with your total customer requirements and your total dependent requirements.

Procedure

Procedure for dealing with total customer requirements

Originally, there were two alternative ways of transferring customer requirements from Sales and Distribution (SD) to Material Requirements Planning (MRP): Individual requirements and total requirements. Individual requirements are stored in table VBEE, whereas total requirements are stored in table VBBS. Table VBBS stores the total demand for a material, plant, and requirement date. This causes a massive amount of data to be loaded, stored, and aggregated on the database at the same time which, on the one hand, speeds up the demand reading process. However, on the other hand, the data involved is locked for further processing; different sales orders requiring the same material at the same date cannot be posted in parallel, for example. When using an in-memory database such as SAP HANA to execute your planning run, however, total requirements are no longer necessary. Your customer demand is aggregated individually at runtime — without having a negative impact on the performance of your MRP.

1. Check whether you have total customer requirements in the system. Use the data browser (transaction SE16) for table VBBS and check the number of entries in that table.
   ○ If there are no entries in table , you have no total customer requirements and therefore you do not have a problem. In this case, proceed with step 7.
   ○ If you have entries in this table, you have total customer requirements and you should proceed with step 2.

2. Check whether you can safely use individual customer requirements. For example, check whether you have custom reports that evaluate table VBBS. These reports should read table VBEE instead.

3. Check the ATP (Available-to-Promise) checking group in Customizing. The ATP checking group defines whether total or individual requirements are created for sales orders.
   ○ In Customizing for Sales and Distribution, under Basic Functions Availability Check And Transfer of Requirements Availability Check Availability Check with ATP Logic or Against Planning Define Checking Groups determine the ATP checking groups with total requirements; an ATP checking group with B (Totals records per day) in column TotalSales or TotDivReqs creates total requirements. If no checking group exists with this entry, the entries you found in table VBBS are meaningless. In this case, proceed with step 7.
   ○ If such a checking group exists, either delete the ATP checking groups that create total requirements or change their TotalSales and TotDivReqs attributes in Customizing from B (Totals records per day) to A
(Single records). This prevents the usage of incorrect ATP checking groups in future. Proceed with step 4.

4. Create and execute the ABAP report `Z_MATERIALS_W_COLLECTIVE_REQS` (transaction SE38) to determine which materials use the ATP checking group that creates total customer requirements. This report finds all the materials with the ATP checking group `01` that creates total requirements. Note that if you have different checking groups that create total requirements, you have to adjust the ABAP report accordingly:

```plaintext
Syntax
data:
    ls_marc type marc.

select matnr werks from marc into (ls_marc-matnr, ls_marc-werks) where mtvfp = '01'.
    write: / ls_marc-matnr, ls_marc-werks.
ENDSELECT.
```

○ If the system does not find any materials, your `VBBS` records are meaningless. In this case, proceed with step 7.
○ If the system finds materials for which the ATP checking group is `01`, proceed with step 5.

5. For every material found by the report in step 4, open the `MRP 3 View` of the `Material Master` in change mode and select an ATP checking group that creates individual requirements.

6. For each material, execute report `SDRQCR21`, `Recovery of Sales and Delivery Requirements` to recreate the customer requirements.

7. Check whether you have implemented any of the methods of the BAdI `MD_CHANGE_MRP_DATA`. If you have and if the BAdI only adds data to MRP evaluations such as `MD04`, re-implement your BAdI implementations in BAdI `MD_ADD_ELEMENTS`.

![Image](image1.png)

```
Note
The BAdI `MD_ADD_ELEMENTS` is processed in MRP evaluations such as `MD04` or `MD07` and is processed in the classic MRP transactions `MD01` or `MD02` or if you have set the `Plan in Classic MRP` indicator for the material in the report `Include Material in Classic MRP` (transaction `MD_MRP_FORCE_CLASSIC`). Check which materials require the processing of a BAdI during the MRP run and set the `Plan in Classic MRP` indicator for these materials.
```

**Procedure for dealing with total dependent requirements**

1. Now check whether you have a problem with total dependent requirements. Use the data browser (transaction SE16) for table `RQIT` and check the number of entries in that table.
   ○ If there are no entries in table `RQIT`, you have no total dependent requirements and therefore you do not have a problem. In this case, proceed with step 5.
   ○ If entries exist in this table, you have total dependent requirements and you should proceed with step 2.

2. Create a planning file entry for every material in table `RQID` (transaction `MD20`) and set the `Net change planning` and the `Re-explode BOM` indicators.

3. If you work with repetitive manufacturing, you have to check and, if necessary, switch off the `Aggregate reqmts` indicator in the repetitive manufacturing profiles in Customizing for `Production`. In combination with the collective requirements indicator in the material master, this indicator determines whether dependent requirements are grouped to collective requirements on a daily basis.
In Customizing for Production, under Repetitive Manufacturing > Control Data > Define Repetitive Manufacturing Profiles, check the Control data 2 tab for each profile to see whether the Aggregate reqmts checkbox is selected. Remove the selection, if necessary.

4. Execute an MRP run which re-explodes all BOMs for the affected materials and creates individual dependent requirements.

5. Create number range PP for planned orders, purchase requisitions, and reservations.

Correct the Secondary Persistence of Sales Documents Relevant to ATP

You use the report ATP_VBBE_CONSISTENCY if there are too many, too few, or incorrect sales documents (quotation, sales order, scheduling agreement) or delivery requirements in your system. You can detect or check this in the stock/requirements list. These inconsistencies may trigger follow-on errors in planning, procurement (production, purchase order) or document processing (availability check).

This report reads all the sales orders and deliveries with open quantities and compares this information with the available entries on the database. By selecting the Simulation Mode checkbox, you can perform this report in simulation. If you do not start the report in simulation mode, all inconsistencies found will be corrected automatically.

10.2.1.2 Production Planning and Detailed Scheduling

Table 5: List of main monitoring transactions:

<table>
<thead>
<tr>
<th>Transaction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMQ1</td>
<td>qRFC Monitor (Outbound Queue)</td>
</tr>
<tr>
<td>SMQ2</td>
<td>qRFC Monitor (Inbound Queue)</td>
</tr>
<tr>
<td>/SAPAPO/CCR</td>
<td>Comparison and Conciliation Report</td>
</tr>
<tr>
<td>/SAPAPO/CPP</td>
<td>CIF Post Processing</td>
</tr>
<tr>
<td>/SAPAPO/CC</td>
<td>Core Interface Cockpit</td>
</tr>
<tr>
<td>/SAPAPO/OM17</td>
<td>Data Reconciliation</td>
</tr>
</tbody>
</table>

Monitoring of HANA integrated liveCache

Following reports are used to check the liveCache integration and functionality, or to check and to reorganize the liveCache data.

- Transaction /sapapo/om13: It is a basic check of the liveCache configuration and of the most important liveCache relevant settings. The “Versions” section displays the version of the currently installed ABAP Support Package, the current version of the HANA LCAPPS Plugin (“Current LCA Version”) and the version of the installed SQLDBC.

  The Checks should be run once after a system installation/upgrade/copy/migration and the alert-marked problems (red traffic light) should be resolved immediately. Click on the corresponding information buttons to display documentation on how to resolve an issue.

- Transaction /SAPAPO/OM03: It provides a brief functional check (should be run once after a system installation/upgrade/copy/migration). Note that this transaction doesn’t change or even clean the main window area, but uses only the status-line at the bottom for its output.
• **Transaction /SAPAPO/OM17**: It provides a collection of consistency checks and repair mechanisms for mainly master data (to be run once in a while, or more frequently for data with occasional new inconsistencies until the root cause isn’t found). This transaction checks the consistency of master data in liveCache by comparing this data with the corresponding data stored in SQL tables of SAP HANA. This transaction also provides an option to resolve master data inconsistencies between liveCache objects and HANA database tables.

### 10.3 Sales

This section of the Operations Guide for SAP S/4HANA contains information on operations tasks specific to **Sales**.

#### 10.3.1 Specific Monitoring Tools for Sales Contract Management

This section of the Operations Guide for SAP S/4HANA contains information about monitoring tools specific to **Sales Contract Management**.

**Global Trade Management**

<table>
<thead>
<tr>
<th>Tool</th>
<th>Transaction</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Trading Contract Synchronization</strong> application log</td>
<td>SLG1</td>
<td>• Display logs for queues (in the <em>External Identification</em> field, choose object WB2_SYNC)</td>
</tr>
<tr>
<td><strong>qRFC Monitor</strong></td>
<td>SMQ1</td>
<td>• Select erroneous queues • Restart queues after errors have been fixed</td>
</tr>
</tbody>
</table>

**Recommendation**

We recommend that you do not to use any time restrictions. You can select the erroneous queues in transaction SMQ1 by using generic search parameters.

<table>
<thead>
<tr>
<th>Type of Queue</th>
<th>Search Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completely generic</td>
<td>WB2_TC_*</td>
</tr>
<tr>
<td>Generic for purchase side</td>
<td>WB2_TC_M*</td>
</tr>
<tr>
<td>Generic for sales side</td>
<td>WB2_TC_V*</td>
</tr>
<tr>
<td>Single document on purchase side</td>
<td>WB2_TC_M_[xxx]</td>
</tr>
</tbody>
</table>
### 10.4 Sourcing and Procurement

This section of the Operations Guide for SAP S/4HANA contains information on operations tasks specific to Sourcing and Procurement.

### 10.4.1 Supplier Information and Master Data

This section contains information for Supplier Information and Master Data.

### 10.4.2 Specific Monitoring Information for Supplier Information and Master Data

Monitoring is essential to running and managing SAP technology. This section provides information about monitoring specifically for Supplier Information and Master Data. For more generic information, see Monitoring [page 8].

#### Table 8: List of Relevant Transactions

<table>
<thead>
<tr>
<th>Transaction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SBGRFCMON</td>
<td>Background remote function calls (bgRFCs) are used in Supplier Evaluation to enable asynchronous creation of documents. You can monitor the calls using transaction SBGRFCMON.</td>
</tr>
</tbody>
</table>
| SLG1          | Logging and tracing for ABAP components are done using transaction SLG1. The objects and subobjects of Supplier Information and Master Data have the namespace /SRMSMC/*. These are:  
- SLC: Supplier Evaluation (/SRMSMC/EVAL)  
  - SLC: Group-Based Evaluation (/SRMSMC/EVAL_GRP_BSD)  
  - SLC: Background Processes in Supplier Evaluation (/SRMSMC/EVAL_BGRD_PR)  
- SLC Tasks (Buy Side) (SRMSMC/TSK_BUY) |
10.4.3 Scheduled Periodic Tasks

You have to schedule the reports listed below as regular jobs:

Table 9: List of Periodic Tasks

<table>
<thead>
<tr>
<th>Program Name / Task</th>
<th>Recommended Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAPConnect: Start Send Process (RSCONN01)</td>
<td>In short intervals; for example, once in 5 minutes</td>
</tr>
<tr>
<td>E-Mail Reminders for Pending Evaluation Responses (/SRMSMC/REM_RESP)</td>
<td>Daily</td>
</tr>
<tr>
<td>E-Mail Reminders for Pending Evaluation Responses (/SRMSMC/REM_RESP)</td>
<td>Daily</td>
</tr>
<tr>
<td>E-Mail Reminders for Tasks (/SRMSMC/REM_TSK)</td>
<td>Daily</td>
</tr>
<tr>
<td>Creation of Evaluation Responses (R_SEV_CREA_RESPONSES)</td>
<td>Does not need to be scheduled periodically; can be started manually if follow-on documents of evaluation requests fail to be created, which causes evaluation requests to remain in status In Submission. For more information, see the system documentation of the report.</td>
</tr>
</tbody>
</table>

10.4.4 Specific Troubleshooting for Supplier Information and Master Data

Below you can find solutions to some problems that may occur:

Table 10: List of Possible Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Suggested Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplier evaluation requests remain in status In Submission because follow-on documents (evaluation responses and evaluation scorecards) are not created.</td>
<td>Start the report Creation of Evaluation Responses (/SRMSMC/R_SEV_CREA_RESPONSES) manually to create the follow-on documents. For more information, see the system documentation of the report.</td>
</tr>
</tbody>
</table>

10.5 Supply Chain

This section of the Operations Guide for SAP S/4HANA contains information on operations tasks specific to Supply Chain.
10.5.1 Efficient Logistics and Order Fulfillment

This section contains information about Efficient Logistics and Order Fulfillment valid for Basic Warehouse Management (S/4HANA).

Data Aging for Material Documents

You can use data aging for your material transaction documents (data aging object MM_MATDOC). Data aging enables you to perform queries on large numbers of material transaction documents in a shorter time and helps you to avoid using valuable memory for historical data that is rarely used.

Restricted Customizing

There is restricted individual Customizing for the data aging object MM_MATDOC. The following system behavior is set by default:

- When starting a data aging run material documents are moved from the current to the historical area in packages of 100,000 material document items by default. You can change the default package size for the data aging procedure in the transaction Data Aging Objects (DAGOBJ).
- The residence time of the data aging object MM_MATDOC in the current area is 2 years by default. You can change the default residence time on a plant level. The relevant Customizing settings are located in the Customizing for Materials Management under General Settings for Materials Management > Data Aging > Data Aging for Material Documents > Define Data Aging for Material Documents.
- The current posting period and the previous posting period are excluded from the data aging process by default.

For more information also see the section Data Archiving and Data Aging [page 13].

10.5.2 Warehouse Management

This section describes specific operational details that are valid for Warehouse Management.

10.5.2.1 Specific Administration Tools for Warehouse Management

This section of the Operations Guide for SAP S/4HANA contains information about administration tools specific to Warehouse Management.

10.5.2.1.1 Scheduled Periodic Tasks

This section describes all tasks that can be automated and that must be run periodically to keep the application running smoothly. Such tasks may be required on component level and are, therefore, relevant in each scenario.
that uses the component. Other tasks may be relevant for certain business scenarios only. It is important that you
monitor the successful execution of these tasks on a regular basis.

The following table contains all the scheduled periodic tasks:

Table 11

<table>
<thead>
<tr>
<th>Program Name/Task</th>
<th>Task Scheduling Tool</th>
<th>Recommended Frequency</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction SARA</td>
<td>Transaction SARA and Definition of Background Jobs</td>
<td>Depends on the archiving object and the database growth</td>
<td>Archives archiving objects (see Data Growth and Data Archiving Monitors [page 38])</td>
</tr>
<tr>
<td>Transaction SLG2 (report SBAL_DELETE)</td>
<td>Definition of Background Jobs</td>
<td>Weekly/monthly</td>
<td>Deletes application logs (see Overview of Trace and Log Files [page 37])</td>
</tr>
<tr>
<td>Report /SCWM/ R_REORG_DATA_CONT</td>
<td>Definition of Background Jobs</td>
<td></td>
<td>Deletes batch processing data from warehouse management monitor</td>
</tr>
<tr>
<td>Report /SCWM/ PI_COMPL_DELETE</td>
<td>Definition of Background Jobs</td>
<td>Yearly</td>
<td>Deletes physical inventory completeness data sets from the years prior to the last year.</td>
</tr>
<tr>
<td>Report RSPPF_SWJCLEAN</td>
<td>Definition of Background Jobs</td>
<td>Weekly/monthly</td>
<td>Deletes technical data from Post Processing Framework (PPF) actions (see SAP Note 1890845)</td>
</tr>
<tr>
<td>Report /SCWM/ PI_PERS_PPF_DEL</td>
<td>Definition of Background Jobs</td>
<td>Periodicity analogous to archiving periods of the physical inventory documents</td>
<td>Warehouse logistics processing: Deletes PPF action data specific to Warehouse Management</td>
</tr>
<tr>
<td>Program Name/Task</td>
<td>Task Scheduling Tool</td>
<td>Recommended Frequency</td>
<td>Detailed Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------</td>
<td>-----------------------</td>
<td>----------------------</td>
</tr>
</tbody>
</table>
| Report /LIME/COLLECTION_DELETE | Definition of Background Jobs | Periodicity analogous to archiving periods of the confirmed warehouse tasks | Warehouse logistics processing: Deletes the dispatch message log for goods movements:  
- Planning System  
- Business Warehouse  
- Financial System  
- Inventory System  
- External System  
- R/3 Inventory Mngmt  
- GL_W2IM: X  
- Minimum Age in Days  
- End Date of Deletion Run: <fill in actual date>  
All processed records will be deleted |
| Report /LIME/BACKGROUND_DELETE_EX | Definition of Background Jobs | Weekly/monthly  
To delete zero quantities, set no other parameter | Inventory: Deletes database entries for zero stock quantities and, on request, index entries without stock. Warehouse Management index tables are as follows:  
- /SCWM/STOCK_IW01  
- /SCWM/STOCK_IW02  
- /SCWM/STOCK_IW03  
- /SCWM/STOCK_IW04  
The index table entries are only deleted if this is allowed in Customizing. For more information, see Customizing for SCM Basis under  
Logistics Inventory Management Engine (LIME) > Basic Settings > Index Tables and Hierarchy > Determine Index Tables |
<p>| Report /SCWM/R_REORG_HU_WO_PRINT | Definition of Background Jobs | Periodicity analogous to archiving periods of the warehouse tasks | Warehouse logistics processing: Deletes PPF action data specific to Warehouse Management |</p>
<table>
<thead>
<tr>
<th>Program Name/Task</th>
<th>Task Scheduling Tool</th>
<th>Recommended Frequency</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report /SCWM/ R_EWM_AUDIT_DELETE_DATA</td>
<td>Definition of Background Jobs</td>
<td>Yearly/monthly</td>
<td>Deletes data that is no longer required for audit purposes</td>
</tr>
<tr>
<td>Report /SCMB/ ALEN_ALERT_DELETE</td>
<td>Definition of Background Jobs</td>
<td>Weekly/monthly</td>
<td>Deletes alerts older than x days</td>
</tr>
</tbody>
</table>
| Report /SCWM/ R_BW_COLLECTIVE_RUN | Definition of Background Jobs | | Transfers extracted data from the following queued remote function call (qRFC) queues to the BI Delta Queue:  
  - WMTB (warehouse task)  
  - WMOB (warehouse order)  
  - WMBB (storage bin)  
  - WMDB (delivery item)  
  - WMVB (value added service) |
| Report /SCWM/ R_WM_ADJUST | Definition of Background Jobs | | Posts differences (for example, warehouse task differences) to the system |
| Report /SCWM/ R_PDO_COMPLETE | Definition of Background Jobs | Daily | Completes outbound delivery order items with zero quantity |
| Report /SCWM/ R_REORG_EXCEPTION_SOLVED | Definition of Background Jobs | Yearly/monthly | Warehouse logistics processing: Deletes the object-related history records of exception code processing |

The following table contains scenario-specific scheduled periodic tasks:

### Table 12

<table>
<thead>
<tr>
<th>Required for Scenarios</th>
<th>Program Name/Task</th>
<th>Recommended Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Production Integration</td>
<td>Report /SCWM/ R_MFG_PDI_COMPLETE</td>
<td>Weekly</td>
<td>Closes unprocessed inbound deliveries from production</td>
</tr>
<tr>
<td>Advanced Production Integration</td>
<td>Report RSQIWKEXI</td>
<td>Hourly</td>
<td>Restarts goods movement queues not executed due to temporary material locks (for example if the same material is received handling unit (HU) by HU for two production orders in parallel production lines)</td>
</tr>
<tr>
<td>Required for Scenarios</td>
<td>Program Name/Task</td>
<td>Recommended Frequency</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Queue Alerting</td>
<td>Report /SCWM/R_QRFC_QUEUE_ALERT</td>
<td>Every 30 – 120 minutes</td>
<td>Creates alert for failed qRFC message</td>
</tr>
<tr>
<td>Queue Alerting</td>
<td>Report RSALERTPROC</td>
<td>Monthly</td>
<td>Deletes old alerts</td>
</tr>
<tr>
<td>Dock Appointment Scheduling</td>
<td>Report /SCWM/R_DAS_DELETE</td>
<td>Monthly</td>
<td>Deletes old SAP Dock Appointment Scheduling time slots and appointments</td>
</tr>
<tr>
<td>Proof of Delivery</td>
<td>Report /SCWM/RPOD_IMP Option Create</td>
<td>Daily</td>
<td>Imports proof-of-delivery (POD) data</td>
</tr>
<tr>
<td>Proof of Delivery</td>
<td>Report /SCWM/RPOD_IMP Option Delete</td>
<td>Monthly</td>
<td>Deletes POD data</td>
</tr>
<tr>
<td>Cartonization Planning</td>
<td>Transaction /SCWM/CAPDEL</td>
<td>Depends on how often planned shipping HUs (PSHUs) are used in the outbound process: weekly, monthly, or yearly</td>
<td>For goods issue posted outbound delivery orders the planned shipping can be deleted. Alternatively you can also delete PSHUs before wave creation with report /SCWM/R_WAVE_PLAN_BACKGROUNDD. To do so, select the Delete Planned Shipping HUs checkbox of the report.</td>
</tr>
<tr>
<td>Labor Management</td>
<td>Report /SCWM/R_MS_RESULT_DELETE</td>
<td>Depends on the usage of measurement services</td>
<td>Labor Management (Analytics): Deletes measurement service results (on the SAP Easy Access screen, choose <strong>Extended Warehouse Management</strong> ➤ <strong>Settings</strong> ➤ <strong>Measurement Services</strong> ➤ <strong>Periodic Processing</strong> ➤ )</td>
</tr>
<tr>
<td>Transit Warehouse</td>
<td>Report /SCWM/R_REORG_HU_TW_PPF</td>
<td>Monthly</td>
<td>HU processing in transit warehouse: Deletes PPF action data specific to Warehouse Management</td>
</tr>
</tbody>
</table>
### Optional Manual Periodic Tasks

This section describes optional manual tasks you can run periodically in order to keep the application running smoothly over time. A manual task needs a user to execute each task, as opposed to scheduled tasks which can be automated using a task scheduler program. Such tasks may be useful on component level and are therefore relevant in each scenario that uses the component. Other tasks may be relevant for certain business scenarios only. It is important that you monitor the successful execution of these tasks on a regular basis.

The following table describes the only optional manual task in Warehouse Management:

<table>
<thead>
<tr>
<th>Required for Scenarios</th>
<th>Tools Supporting this Task</th>
<th>Recommended Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dock Appointment Scheduling</td>
<td>Web Dynpro Application / SCWM/DSSLOT_GEN</td>
<td>Depends on the usage of time slots in SAP Dock Appointment Scheduling: weekly or monthly</td>
<td>For the creation of time slots in the graphical view of SAP Dock Appointment Scheduling</td>
</tr>
</tbody>
</table>

### Specific Monitoring Tools for Warehouse Management

Warehouse Management provides the warehouse management monitor as a central place to monitor your business processes from the business and the technical perspective. You can start the monitor on the SAP Easy

## 10.5.2.2.1 Interface Monitors

Interface monitors are essential for analyzing problems with interfaces such as remote function call (RFC), IDoc, and HTTP. The following table contains all the interface monitors in Warehouse Management:

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
<th>Technology Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery Processing</td>
<td>Communication based on deliveries or warehouse requests as the foundation for logistics execution in Warehouse Management</td>
<td>Queued remote function call (qRFC)</td>
</tr>
<tr>
<td></td>
<td>Relevant for all systems</td>
<td></td>
</tr>
<tr>
<td>Goods Movement</td>
<td>Goods movements that are not directly related to a delivery document</td>
<td>qRFC</td>
</tr>
<tr>
<td></td>
<td>Relevant for all systems</td>
<td></td>
</tr>
<tr>
<td>Production</td>
<td>Asynchronous creation of production material requests based on production and process orders as the foundation for logistics execution in Warehouse Management</td>
<td>qRFC</td>
</tr>
<tr>
<td></td>
<td>Optional business process</td>
<td></td>
</tr>
<tr>
<td>BI Data Sources</td>
<td>SAP Business Information Warehouse and Warehouse Management</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Transportation Integration (SAP TM)</td>
<td>SAP Transportation Management (SAP TM) and Warehouse Management Web services</td>
<td>SAP NetWeaver Process Integration (SAP NetWeaver PI) + Web service</td>
</tr>
<tr>
<td></td>
<td>Web services</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Optional business process</td>
<td></td>
</tr>
<tr>
<td>Warehouse Billing</td>
<td>SAP TM</td>
<td>SAP NetWeaver PI + Web service</td>
</tr>
<tr>
<td></td>
<td>Web services</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Optional business process</td>
<td></td>
</tr>
<tr>
<td>Quality Inspection</td>
<td>Integration of quality inspection Optional business process</td>
<td>qRFC</td>
</tr>
<tr>
<td>Global Trade Compliance Check</td>
<td>SAP Global Trade Services and Warehouse Management Optional business process</td>
<td>RFC, qRFC</td>
</tr>
<tr>
<td>Material Flow System</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Yard Management</td>
<td>Web services for non-SAP systems</td>
<td>SAP NetWeaver PI + Web service</td>
</tr>
<tr>
<td>Interface</td>
<td>Description</td>
<td>Technology Used</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Optional interface</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delivery Notifications</td>
<td>Web services for non-SAP systems</td>
<td>SAP NetWeaver PI + Web service</td>
</tr>
<tr>
<td>Optional interface</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The monitor tools for these interfaces are as follows:

<table>
<thead>
<tr>
<th>Interface</th>
<th>Monitor</th>
<th>Description</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery Processing</td>
<td>SMQ1/SMQ2</td>
<td>Standard qRFC monitoring as described in the application help for SAP NetWeaver Queues beginning with DLVS or DLWS The queue should be monitored within one month as a goods movement can only be posted in the current and previous period (for example, a goods movement sent to the queue on July 15 must be posted on August 31 at the latest).</td>
<td>Create settings for qRFC scheduling and administration in transactions SMQE, SMQS, and SMQR as described in the Integration Guide.</td>
</tr>
<tr>
<td>Goods Movement</td>
<td>SMQ1/SMQ2</td>
<td>Standard qRFC monitoring as described in the application help for SAP NetWeaver Queues beginning with EWMGOODSMVT, WMPGR, or WMPGI For the monitoring of queues, see row Delivery Processing above.</td>
<td>Create settings for qRFC scheduling and administration in transactions SMQE, SMQS, and SMQR as described in the Integration Guide.</td>
</tr>
<tr>
<td>Production (Production Material Request)</td>
<td>SMQ1/SMQ2</td>
<td>Standard qRFC monitoring as described in the application help for SAP NetWeaver Queues beginning with PR</td>
<td>Create settings for qRFC scheduling and administration in transactions SMQE, SMQS, and SMQR as described in the Integration Guide.</td>
</tr>
<tr>
<td>BI Data Sources</td>
<td>SMQ1/SMQ2</td>
<td>Standard qRFC monitoring as described in the application help for SAP NetWeaver Queues beginning with WMBB, WMDB, WMTB, WMOB, or WMVB</td>
<td></td>
</tr>
<tr>
<td>Interface</td>
<td>Monitor</td>
<td>Description</td>
<td>Prerequisites</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transportation Integration</td>
<td>SXMB_MONI</td>
<td>Standard SAP NetWeaver PI monitoring as described in the application help for SAP NetWeaver</td>
<td></td>
</tr>
<tr>
<td>(SAP TM)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Warehouse Billing</td>
<td>SXMB_MONI</td>
<td>Standard SAP NetWeaver PI monitoring as described in the application help for SAP NetWeaver</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Material Flow System</td>
<td>/ SCWM/MON (node [Material Flow System &gt; Telegram Buffer])</td>
<td>Communication between Warehouse Management and programmable logic controllers (PLCs)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yard Management</td>
<td>SXMB_MONI</td>
<td>Standard SAP NetWeaver PI monitoring as described in the application help for SAP NetWeaver</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delivery Notifications</td>
<td>SXMB_MONI</td>
<td>Standard SAP NetWeaver PI monitoring as described in the application help for SAP NetWeaver</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note**

As an alternative to the technical monitoring, you can monitor the qRFC messages in a business context. In the warehouse management monitor (transaction / SCWM/MON) under node [Tools > Message Queue > Message Queue Monitoring], you can get a list of Warehouse Management-relevant queues. The system enriches the list with relevant information for a business user such as the warehouse number and texts. You can use this additional option for monitoring queues without additional configuration. You can also adapt the selection to the needs of your users in Customizing for Extended Warehouse Management under [Monitoring > Warehouse Management Monitor > Message Queue Monitoring].

You can configure e-mail and SMS alerts for failed queues. Therefore you do not need to monitor the queues actively. For more information, see SAP Library for SAP S/4HANA at help.sap.com/s4hana. In SAP Library, choose [SAP S/4HANA > Enterprise Business Applications > Supply Chain > Extended Warehouse Management > Monitoring > Warehouse Management Monitor > Message Queue Monitor].

Warehouse Management uses the qRFC for internal messages to achieve minimal response time for users who need to work with a high throughput. These queues also need to be monitored. You can do the monitoring as described for the interfaces above, using transaction SMQ2/SMQ1 for queues starting with WM, EWM, or DLV. Alternatively, you can use the warehouse management monitor to display the queues with additional business data as described above.
10.5.2.3 Overview of Trace and Log Files

Warehouse Management uses the application log (part of SAP NetWeaver) to store application errors, warnings, and success messages issued in critical processes (for example, the delivery interface or in user interface (UI) transactions. For UI transactions, the user has to save the application log explicitly.

For general information on application logs, see SAP Library for SAP NetWeaver at help.sap.com/nw. In SAP Library, choose Function-Oriented View > Solution Life Cycle Management > Application Log – (BC-SRV-BAL).

You can monitor the application logs with transaction SLG1 or in the warehouse management monitor under Tools > Application Log.

The following table contains all the trace and log files in Warehouse Management:

<table>
<thead>
<tr>
<th>Log Object</th>
<th>Detailed Description</th>
<th>Activation/Deactivation</th>
</tr>
</thead>
<tbody>
<tr>
<td>/SCWM/DLV_ERP</td>
<td>Delivery Processing: Stores error messages issued during the queued remote function call (qRFC) communication of deliveries with an expiry time of seven days.</td>
<td>The system saves the log automatically when the qRFC fails. If you need a log for messages that were processed without error for test purposes, you can change the settings in transaction /SCWM/ERPLOG (on the SAP Easy Access screen choose Extended Warehouse Management &gt; Settings &gt; Application Log &gt; Configure Log for ERP Messages).</td>
</tr>
<tr>
<td>/SCMB/PATTERN_UI</td>
<td>Log for UI messages</td>
<td>Log has to be saved explicitly in the Warehouse Management UI transactions.</td>
</tr>
<tr>
<td>/SCWM/WME</td>
<td>Warehouse Logistics Processing: Log for Warehouse Management operations</td>
<td>Log has to be activated with transaction /SCWM/ACTLOG (on the SAP Easy Access screen choose Extended Warehouse Management &gt; Settings &gt; Activate Application Log). You can activate the application log on sub-object level.</td>
</tr>
<tr>
<td>/SCWM/SHP_RCV</td>
<td>Site Logistic Processing: Log for shipping and receiving transactions</td>
<td></td>
</tr>
<tr>
<td>/SCWM/EPD</td>
<td>Labor Management: Log for sending performance documents to human resources (HR)</td>
<td>Log has to be saved explicitly by the user in transaction /SCWM/EPD_TRANSFER (on the SAP Easy Access screen choose Extended Warehouse Management &gt; Labor Management &gt; Employee Performance &gt; Send Performance Document to HR).</td>
</tr>
</tbody>
</table>

Operations Guide for SAP S/4HANA 1610
SAP S/4HANA Enterprise Management
PUBLIC
© Copyright 2016 SAP SE or an SAP affiliate company.
All rights reserved. 37
<table>
<thead>
<tr>
<th>Log Object</th>
<th>Detailed Description</th>
<th>Activation/Deactivation</th>
</tr>
</thead>
<tbody>
<tr>
<td>/SCMB/MD</td>
<td>Master Data: Log for deleting supply chain units</td>
<td></td>
</tr>
<tr>
<td>/SCWM/PACKSPEC</td>
<td>Master Data: Log for packaging specifications</td>
<td>The log for the determination analysis has to be activated in transaction /SCWM/PSLOG. The log for uploading packaging specifications has to be saved explicitly by the user in transaction /SCWM/IPU (on the SAP Easy Access screen choose SCM Basis &gt; Master Data &gt; Packaging Specification &gt; Initial Data Transfer of Packaging Specifications).</td>
</tr>
<tr>
<td>PPF</td>
<td>Post Processing Framework</td>
<td>The log is always active. You can deactivate the log for delivery processing in transaction /SCWM/DLVPPFLOG (on the SAP Easy Access screen choose Extended Warehouse Management &gt; Delivery Processing &gt; Actions &gt; Deactivate PPF Log Depending on Warehouse and User).</td>
</tr>
<tr>
<td>/SCWM/CHM</td>
<td>Warehouse Management Check Monitor</td>
<td></td>
</tr>
<tr>
<td>/SCWM/DAS</td>
<td>SAP Dock Appointment Scheduling</td>
<td>The log is used for asynchronous processes and reports in SAP Dock Appointment Scheduling. By default it is written for errors and warnings. You can change the activation of the log in transaction /SCWM/DSLOG.</td>
</tr>
</tbody>
</table>

During the implementation and test phase, or when you need to investigate an issue, you should activate the related logs. Once the system is running smoothly, you can improve the performance if you configure the logs to record only Important or Very Important messages or deactivate them completely.

For descriptions of the recommended tasks to contain data growth, see Scheduled Periodic Tasks [page 28].

### 10.5.2.4 Data Growth and Data Archiving Monitors

Warehouse Management uses the standard tools available in SAP NetWeaver and does not require a component-specific tool. For more information, see the SAP NetWeaver Operations Guide on SAP Service Marketplace at service.sap.com/operationsnw75.

You can archive the following data in Warehouse Management:
<table>
<thead>
<tr>
<th>Application Component</th>
<th>Business Object/Document Category</th>
<th>Archiving Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warehouse Request Processing</td>
<td>Internal Warehouse Requests (Inbound Delivery)</td>
<td>DLV_INB</td>
</tr>
<tr>
<td></td>
<td>Internal Warehouse Requests (Outbound Delivery)</td>
<td>DLV_OUT</td>
</tr>
<tr>
<td></td>
<td>Production Material Requests</td>
<td>DLV_PROD</td>
</tr>
<tr>
<td>Stock Management</td>
<td>Handling Units</td>
<td>WME_HU</td>
</tr>
<tr>
<td>Warehouse Logistic Processing</td>
<td>Warehouse Tasks and Goods Movement Documents</td>
<td>WME_TO</td>
</tr>
<tr>
<td></td>
<td>Warehouse Orders</td>
<td>WME_WO</td>
</tr>
<tr>
<td></td>
<td>Waves</td>
<td>WME_WAVE</td>
</tr>
<tr>
<td></td>
<td>Telegram Flows</td>
<td>WME_MFS</td>
</tr>
<tr>
<td></td>
<td>Relevant Resource Data</td>
<td>WME_RSRC</td>
</tr>
<tr>
<td></td>
<td>Value-Added Service Orders (VAS Orders)</td>
<td>WME_VAS</td>
</tr>
<tr>
<td></td>
<td>Physical Inventory Documents</td>
<td>LIME_PI</td>
</tr>
<tr>
<td></td>
<td>LIME Log Entries (goods movements and confirmed warehouse tasks). Periodicity analogous to WME_TO.</td>
<td>LIME_NLOG</td>
</tr>
<tr>
<td>Site Logistic Processing</td>
<td>Door Activities</td>
<td>WME_DOOR</td>
</tr>
<tr>
<td></td>
<td>Vehicle Activities</td>
<td>WME_VEH</td>
</tr>
<tr>
<td></td>
<td>Transport Unit Activities</td>
<td>WME_TU</td>
</tr>
<tr>
<td>Labor Management</td>
<td>Indirect Labor Tasks</td>
<td>WME_ILT</td>
</tr>
<tr>
<td></td>
<td>Executed Workloads</td>
<td>WME_EWL</td>
</tr>
<tr>
<td></td>
<td>Employee Performance Documents</td>
<td>WME_EPD</td>
</tr>
<tr>
<td></td>
<td>Business Partners (Processors) – only if created originally in Warehouse Management</td>
<td>CA_BUPA</td>
</tr>
<tr>
<td>Express Shipping Interface</td>
<td>Manifests</td>
<td>EWM_ESI_MF</td>
</tr>
<tr>
<td></td>
<td>Parcels</td>
<td>EWM_ESI_PA</td>
</tr>
<tr>
<td>Warehouse Billing</td>
<td>Warehouse Management Warehouse Billing Measurements</td>
<td>EWM_WBM</td>
</tr>
</tbody>
</table>
10.5.2.5  Data Consistency

Warehouse Management exchanges data with other solutions in SAP S/4HANA using asynchronous messages. Monitor the queued remote function call (qRFC) messages in the system as described in Interface Monitors [page 34].

You can check the consistency of your Warehouse Management system using transaction /SCWM/CHM_PRF (Maintain Check Monitor Profile). The particular checks are documented in the transaction.

10.6  Enterprise Technology

This section of the Operations Guide for SAP S/4HANA contains information on operations tasks specific to Enterprise Technology.

10.6.1  SAP Application Interface Framework

This guide provides an overview of the system operations that are specific to the SAP Application Interface Framework.

Features

The SAP Application Interface Framework provides you with the following options for analyzing system operations:

- Archive data (see Data Archiving [page 41])
- Measure the performance of the SAP Application Interface Framework (see Performance Analysis [page 42])
- Examine interface data for the number of messages and errors (see Index Table Overview [page 44])
- Get an overview of the objects that are used by a specific interface (see Interface Objects Summary [page 45])
- Investigate log content for the changes made to the data messages of the selected interface (see Application Log Content [page 45])
- Display changes made in Error Handling to the data messages of the selected interface (see Error Handling Changes Log [page 46])
- The Data Correction Report checks for inconsistencies between the Proxy Framework and the SAP Application Interface Framework and corrects them (see Data Correction [page 47])
- A snapshot takes the content in the statistics tables at a specific point of time (see Generation and Display of Snapshots [page 48])
10.6.1.1 Data Archiving

Data Archiving – a service provided by SAP NetWeaver – removes mass data that the system no longer needs online, but which must still be accessible at a later date, if required, from the database.

In the SAP Application Interface Framework, you can archive the following types of data:

- Data messages
- XML persistence
- Data changes
- Runtime objects
- Application logs
- Structured persistence
- File adapter logs
- Snapshots

Prerequisites

Data in the database can only be archived using archiving objects, which describe the data structure and context.

To set up Data Archiving (transaction code SARA) for the SAP Application Interface Framework, you enter the name of the SAP Application Interface Framework-specific archiving object /AIF/PERSX in the Object Name field on the Archive Administration: Initial Screen.

The archiving uses the Archive Development Kit (ADK) to provide the archiving object /AIF/PERSX, which includes all the necessary archiving programs and defines the structure of the archive file to be written. To maintain the archiving object, use transaction AOBJ.

All archiving programs maintained in the archiving object are started using Archive Administration (transaction code SARA).

Process

In the SAP Application Interface Framework, the archiving process is divided into the following main steps, some of which are optional:

1. Creation of archive files

In the write phase, the data to be archived is written sequentially into newly created archive files.

In the SAP Application Interface Framework, the AIF Data Archiving: Write Program (/AIF/PERSX_WRI) report controls the writing process of the archive files produced by the archiving object /AIF/PERSX. You can decide which data should be archived using a variant and a selection screen.

On the selection screen, you can select the types of data you want to archive. You can further restrict the selection using dates and users. For data messages, XML persistence, structured persistence, data changes, and application logs, you can restrict using the interfaces. In addition, there are many type-specific selection parameters. By defining the package size, you can optimize the performance and memory consumption of the archiving runs. In addition, you can tweak the layout of the resulting logs.

You can run the write program of the archiving object in test mode, which means that the program simulates the creation of an archive, based on your selection criteria and other archiving object-specific checks that test the data’s suitability for archiving. The program does not create an archive file but does generate
statistics about which table entries would be written to the archive and the size and number of archive files that would be created in production mode.

Once you schedule the write process, you can monitor the corresponding job on the Job Overview screen.

 Recommendation
We recommend that you schedule the archiving as periodic background jobs that run in off-peak hours.

2. Deletion from the database
The delete program reads the data from the archive files and deletes the data from the database.

In the SAP Application Interface Framework, you can use the Archiving of the AIF Persistence: Delete Program (/AIF/PERSX_DEL) report to control the deletion of persistence entries that have been written successfully to an archive file and to generate statistics about the table entries that were deleted.

If you run the delete program of the archiving object in test mode, data is not deleted from the database as the deletion is only simulated.

Once you schedule the deletion process, you can monitor the corresponding job on the Job Overview screen.

3. Optional: Display of archive files
You can use the Archiving of the AIF Persistence: Sequential Read Program (/AIF/PERSX_READ) report to display the data stored in archive files of the archiving object /AIF/PERSX. If you double click on a line, more details about the corresponding entry are displayed.

4. Optional: Reloading of archive files
You can use the Archiving of the AIF Persistence: Reload Program (/AIF/PERSX_REL) report to reload successfully archived data, produced by the archiving object /AIF/PERSX, to the SAP Application Interface Framework tables.

You can also run the reload program in test mode. The reload is only simulated and there are no changes made to the database.

Once you select a successfully deleted archiving session, maintain the variant, and schedule the reload process, the corresponding job is displayed on the Job Overview screen.

 Recommendation
We recommend that you use this feature in exceptional circumstances only.

More Information
For more information about archiving, see the SAP Help Portal under Introduction to Data Archiving (CA-ARC).

10.6.1.2 Performance Analysis

You can use Performance Tracking (transaction code /AIF/PERFORMANCE) to measure the performance of the SAP Application Interface Framework. Using this performance analysis tool, you are able to detect time-consuming routines and processes within the SAP Application Interface Framework.

Using tracking variants available in this transaction, you can track the performance of specific objects, for example, particular interfaces, users, and time ranges within the SAP Application Interface Framework.
Goals
The goals of the performance optimization process and the Performance Tracking transaction include:

- Measuring interface performance in back end systems
- Determining the area for performance improvements (for example, interface-specific logic and mapping logic)
- Defining measures for bottlenecks with most saving potential
- Implementing performance improvement measures
- Confirming the positive impact of performance improvement measures

Features
Scope
The scope of the interface performance measuring is defined for all interfaces via SAP NetWeaver Process Integration and the SAP Application Interface Framework.

The following are measured:

- ABAP Proxy
- Interface-specific logic (for example, value mappings and validations)
- Posting logic (for example, BAPIs)

The following are not measured:

- Legacy extractors
- Transmission of data (for example, file transfer and MQSeries)
- SAP NetWeaver Process Integration

Activities
You can access the Performance Tracking report from the SAP Easy Access menu by choosing Cross-Application Components > SAP Application Interface Framework > Administration > Tools > Performance Tracking.

Set Up Tracking
In order to track performance, a variant needs to be set up. You can either select a variant that already exists or create a new variant. If you select an existing variant, the corresponding data for the variant is displayed on the screen.

If a variant has not been created, the default values are shown in the selection screen of the transaction and the variant is marked as Unsaved. While creating a variant on the selection screen, you can specify a message ID, namespace, interface name, interface version, and the name of the user starting the message. You can also enter the minimum duration and the time range.

You can start tracking by choosing (Start Tracking). You can stop tracking by choosing (Stop Tracking).

Analyze Results
Performance issues could arise in the following areas:

- Interface-specific logic
• Posting logic (for example, SAP BAPIs)

Examples of performance issues in above areas and possible solutions for you for these issues are shown in the following table:

Table 18

<table>
<thead>
<tr>
<th>Examples of Performance Issues</th>
<th>Possible Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequent selection of identical data, for example, function modules that are Customized on an item level</td>
<td>Buffering in hashed internal table</td>
</tr>
<tr>
<td>Slow select statements, for example, database index not used</td>
<td>• Usage of database index, if available</td>
</tr>
<tr>
<td></td>
<td>• Creation of database index, if feasible</td>
</tr>
<tr>
<td></td>
<td>• Database access via alternative table</td>
</tr>
<tr>
<td>Long read access to internal tables</td>
<td>• Usage of sorted or hashed tables</td>
</tr>
<tr>
<td></td>
<td>• Usage of field symbols</td>
</tr>
<tr>
<td>Long runtime of SAP BAPIs</td>
<td>• Check for user exits with poor performance</td>
</tr>
<tr>
<td></td>
<td>• Redesign of interface if BAPI supports multi-post</td>
</tr>
</tbody>
</table>

10.6.1.3 Index Table Overview

The Index Tables Overview report (transaction code /AIF/IDXTBL) gives you an overview about the number of messages and the number of errors that exist for each interface of the SAP Application Interface Framework.

Features

On the selection screen of the Index Table Overview transaction, you can select the namespace, interface name, and interface version. If you leave those fields blank, all interfaces that exist are selected. In addition, you can decide if only error messages are to be counted or if all existing messages are to be counted.

Activities

You can access the Index Table Overview report from the SAP Easy Access menu by choosing Cross-Application Components > SAP Application Interface Framework > Administration > Tools > Index Table Overview.

Example

An interface administrator runs the report to check if the message number for each interface is within the expected range. The administrator identifies an unusual high number of messages for one interface and decides to do the following:

• Checks that data archiving is set up for the interface
• Ensures that performance is still good in the error handling
• Runs a performance report
• Checks technical attributes of the corresponding single index table in order to see if it is optimized for such a large number of messages

10.6.1.4 Interface Objects Summary

The Summary Report (transaction code /AIF/CUST_OVERVIEW) provides an overview of the objects in the SAP Application Interface Framework that are used by a specific interface. The SAP Application Interface Framework introduces several objects for the development of interfaces, for example, value mappings, fix values, checks, and actions. Since most of these objects are maintained in different locations in the SAP Application Interface Framework, there is no aggregated view of all the objects used by a specific interface. The Summary Report provides you with such a consolidated view.

Activities

You can access the Summary Report from the SAP Easy Access menu by choosing Cross-Application Components ➤ SAP Application Interface Framework ➤ Administration ➤ Tools ➤ Summary Report.

10.6.1.5 Application Log Content

Interface Logs (transaction code /AIF/LOG) offers you a specialized view of the transaction to analyze the application log (transaction code SLG1). In the specialized view, the log object is predefined as /AIF/LOG, so that only application log messages created by the SAP Application Interface Framework are displayed.

Features

On the Select Interface Logs screen, you have options to restrict the selection, for example, by using the following:

• **Subobject**
  In the SAP Application Interface Framework, this refers to the namespace and interface name.

• **External ID**
  The message GUID or a file number of the test tool

• **Time Restriction**
  You can define a date and time range.

• **Log Triggered By**
  The user, transaction code, or program that triggered the log

• **Log Class**
  All logs or logs with various degrees of importance

In the upper part of the Display Interface Log Messages output screen, the selected application log messages are displayed grouped by the date, time, and user. An icon shows whether the messages have the message type Information, Warnings, Error, or Termination depending on the highest error status of the group. When you select an icon, the number of individual messages for each individual message type is displayed. When you then select
an icon, for example, for those with message type Error. The details for the individual log messages with message type Error are displayed in the lower part of the output screen.

Activities

You can access the Interface Logs report from the SAP Easy Access menu by choosing Cross-Application Components ➔ SAP Application Interface Framework ➔ Administration ➔ Log ➔ Interface Logs.

More Information

For more information about the application log, see SAP Help Portal at SAP NetWeaver ➔ SAP NetWeaver 7.0 (2004s) ➔ SAP NetWeaver 7.0 Library (English) ➔ SAP NetWeaver Library ➔ SAP NetWeaver by Key Capability ➔ Solution Life Cycle Management by Key Capability ➔ Application Log – (BC-SRV-BAL).

10.6.1.6 Error Handling Changes Log

You can use the Error Handling Changes Log (transaction code /AIF/EDCHANGES) to display the changes made to the data messages of the selected interface or interfaces in Error Handling.

Features

You can restrict the selection by namespace, interface name, and version. You can refine the selection by entering a date range or the message ID.

On the output screen, a tree view displays all selected interfaces. When you select a node, the following changes made to the messages are displayed:

- The GUID of the data message
- The field path of the field that was changed by the user
- LINE_NR that contains the message index with line numbers
- The new and old value
- The date and time of the modification

Activities

You can access the Error Handling Changes Log report from the SAP Easy Access menu by choosing Cross-Application Components ➔ SAP Application Interface Framework ➔ Administration ➔ Log ➔ Error Handling Changes Log.
10.6.1.7 Data Correction

There might be inconsistencies between the Proxy Framework and the SAP Application Interface Framework. The Data Correction Report (transaction code /AIF/CORRECTION_REPORT) checks for inconsistencies and corrects them. A test mode exists that allows you to check for inconsistencies but not to actually correct them. By default, the Testrun checkbox is selected.

Features

The following inconsistencies can be fixed:

- There might be inconsistencies between the message status in the Proxy Framework and the single index tables in the SAP Application Interface Framework. These inconsistencies can occur if a message was canceled, deleted, or archived in the Proxy Framework, but the status was not updated in the single index tables of the SAP Application Interface Framework.

- There might be inconsistencies between the message index table and the SAP NetWeaver PI message status. These inconsistencies occur if a message, which ended with errors in the SAP Application Interface Framework, is restarted with the Proxy Framework and processed successfully. In this case, the status in the SAP Application Interface Framework might not be updated.

- If an SAP NetWeaver PI message was deleted or archived, the corresponding application log written by the SAP Application Interface Framework must be deleted. Inconsistencies must be corrected.

- When there are changes made in Customizing for alert recipients, the alert index table might not be updated correctly. Therefore, the table might contain inconsistent records when compared to current Customizing for alert recipients. You can regenerate the messages’ statistics to ensure that no inconsistencies exist and the messages’ statistics can be compressed.

When running the Data Correction Report, the system checks for messages that exist in the message index tables of the SAP Application Interface Framework but not in the Proxy Framework. These are regarded as inconsistent and are deleted from the message index tables of the SAP Application Interface Framework. It is recommended to also delete the corresponding application log messages. Hence, the Data Correction Report should be planned as a background job after execution of the deletion or archiving jobs for the Proxy Framework with the following settings:

- **Namespace**, **Interface Name**, and **Interface Version** should be blank
- **Testrun** should not be selected
- **Check/Fix Deleted or Archived Messages** should be selected
- **Check/Fix Application Log** should be selected
- **Regenerate Statistics** should be selected

Activities

You can access the Data Correction Report from the SAP Easy Access menu by choosing ➤ Cross-Application Components ➤ SAP Application Interface Framework ➤ Administration ➤ Tools ➤ Correction Report ➤.


➡️ Recommendation
It is recommended that the *Data Correction Report* is run regularly as a background job to ensure that no inconsistencies exist.

➡️ Recommendation
It is further recommended that you run the *Data Correction Report* after your deletion or archiving job for messages in the Local Integration Engine was executed.

### 10.6.1.8 Generation and Display of Snapshots

In the SAP Application Interface Framework you are able to generate and display snapshots. A snapshot takes the content in the statistics tables (`/AIF/MSG_STAT` and `/AIF_MSGSTATALL`) at a specific point of time and saves it in separate snapshot tables. The same applies to the message summary table (`/AIF/T_MMSG_IDX`).

#### Features

**Generation of Snapshots**

A snapshot can be taken using *Generate Snapshot* (transaction code `/AIF/GENMSGSNAP`). This transaction allows you to create snapshots of statistics and summary data for messages in the SAP Application Interface Framework and track this data over time.

On the *Generate Snapshot* selection screen, select a date for which the snapshot is to be created (this only applies to daily statistics data). You can also select a package size, that is, the size of the packages in which the single messages are processed. Changing the number of the package size could increase or decrease the performance of the report considerably. **1000** is the suggested value for most situations. However, the optimum package size depends on the system hardware and the current system load.

**Display of Snapshots**

A snapshot can be displayed using *Display Snapshot* (transaction code `/AIF/DISPMSGSNAP`). This transaction allows you to display snapshots of statistics and summary data for messages available in the SAP Application Interface Framework and track this data over time.

There are several ways you can filter for snapshots, for example, ID, creation data, creation user, and the date the snapshot was created.

You can select from the following 4 views:

  Lists all the statistics entries for messages available in the system at the time of snapshot creation.

- **(Daily Message Statistics)**
  Lists all the message statistics for the *effective date* specified for the snapshot.

  Lists all the log message entries available in the system at the time of snapshot creation. Log messages are grouped and their amount cumulated on the basis of namespace, interface name, interface version, recipient
namespace, recipient name, message type, message ID, and message number. You can see the message text (with placeholders) and the key fields that were the basis for the determination of the specific recipient.

- *(Daily Message Summary)*

  Shows all the log messages for a specific date, that is, the effective date of the snapshot.

**Activities**

You can access the reports to generate and display error statistics snapshots from the SAP Easy Access menu by choosing **Cross-Application Components > SAP Application Interface Framework > Administration > Snapshots** and **Generate Snapshot or Display Snapshot**.

**Recommendation**

It is recommended that **Generate Snapshot** is run daily as a background task.

10.7  R&D / Engineering

This section of the Operations Guide for SAP S/4HANA contains information on operations tasks specific to R&D / Engineering.

10.7.1  Product Lifecycle Management

This section describes specific operational details that are valid for Product Lifecycle Management (PLM).

10.7.1.1  Specific Monitoring Tools for PLM

This section of the Operations Guide for SAP S/4HANA contains information about monitoring tools specific to Product Lifecycle Management.

**Workload Monitors**

Product Lifecycle Management uses the standard NetWeaver workload monitor. For more information, see the SAP Help Portal under help.sap.com/s4hana_op_1610_002 ➔ **SAP NetWeaver for SAP S/4HANA ➔ Technical Operations for SAP NetWeaver ➔ Administration of SAP NetWeaver systems and components ➔ Administration of Application Server ABAP ➔ Monitoring and Administration Tools for Application Server ABAP ➔ Workload Monitor ➔**
### Interface Monitors

Interface monitors are essential for analyzing problems with interfaces such as RFC, IDoc, and HTTP. If you create RFC connections for running your PLM system landscape, use standard SAP NetWeaver tools for monitoring these RFC connections. For more information, see the SAP Help Portal under help.sap.com/s4hana_op_1610_002 > SAP NetWeaver for SAP S/4HANA > Function-Oriented View > Application Server > Functions and Tools of SAP NetWeaver Application Server > Connectivity > Components of SAP Communication Technology > Classic SAP Technologies (ABAP) > RFC > RFC Administration.

#### 10.7.1.2 High Availability for PLM

*Product Lifecycle Management* follows the general high availability (HA) concept for all SAP NetWeaver based systems. For more information, see *Business Continuity and High Availability* [page 15].

In particular, you can protect Product Lifecycle Management from downtimes using redundancy approaches such as installations on at least two different runtime environments or physical machines. A load balancing or dispatching mechanism ensures that in case of a downtime of one runtime or physical machine the remaining ones can handle all requests.

#### 10.7.1.3 Specific Troubleshooting for PLM

If errors occur during the operation of the PLM Web UI applications, we recommend that you create a BCP ticket under the corresponding application component (they all start with PLM-WUI*).

For more information about how to operate SAP NetWeaver Enterprise Search, see the SAP Help Portal under help.sap.com/s4hana_op_1610_002 > SAP NetWeaver for SAP S/4HANA > Function-Oriented View > Search and Operational Analytics > Enterprise Search.
11 SAP S/4HANA LoB Products

This section of the Operations Guide for SAP S/4HANA contains specific operations information for the functionality included in SAP S/4HANA LoB Products.

11.1 Asset Management

This section of the Operations Guide for SAP S/4HANA contains information on operations tasks specific to Asset Management.

11.1.1 Environment, Health, and Safety

This section of the Operations Guide for SAP S/4HANA contains information for Environment, Health, and Safety valid for:

- Incident Management
- Environment Management
- Health and Safety Management

11.1.1.1 Specific Monitoring Tools for EHS

Monitoring is essential to running and managing SAP technology. The following sections provide information about monitoring specifically for Environment, Health, and Safety. For more generic information, see Monitoring [page 8].

11.1.1.1.1 Monitoring Processes and Workflows in EHS

The process foundation is essential to the business processes supported by Environment, Health, and Safety. It links together the SAP Business Workflow engine and the BOPF business objects of Environment, Health, and Safety for all the solution’s components.

You can monitor the processes with the following process tools:

- EHFND_WFF_PRCDEF_LST
- EHFND_WFF_PROCS_LST
11.1.1.1.2 Monitoring Scheduled Processes

The process scheduler of *Environment, Health, and Safety* is used for recurring tasks and planned execution of a process instance. You can use the following transactions to monitor the scheduled processes:

Table 19: List of Transactions

<table>
<thead>
<tr>
<th>Transaction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLG1</td>
<td>Application log</td>
</tr>
<tr>
<td>SM37</td>
<td>Job log</td>
</tr>
<tr>
<td></td>
<td>The scheduler uses a self-rescheduling job to do its work. In addition to the application log, you can also find information about the scheduler executions in this transaction.</td>
</tr>
<tr>
<td></td>
<td>To display only the jobs related to the <em>Environment, Health, and Safety</em> scheduler, you can filter by job name R_EHFND_SCHEDULER_JOB. In addition, you should change the user name parameter to &quot;*&quot; (asterisk) as the jobs are always run under the last user that created a scheduler entry.</td>
</tr>
</tbody>
</table>

For more information about the log objects for the scheduler, see *Overview of Application Log Objects* [page 54].

11.1.1.1.3 SAP Business Workflow Log

You can use the workflow log to inspect workflow instances. You can use either the standard view for end-users or the technical view. The technical view contains additional options for developers and administrators, such as inspecting workflows and work item containers.

To access the workflow log, you can use the following standard transactions to find a workflow:

Table 20: List of Transactions

<table>
<thead>
<tr>
<th>Transaction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SWI6</td>
<td>Workflows for Object</td>
</tr>
<tr>
<td></td>
<td>Use this if you know the ABAP class and key of the PCO that is related to the workflow that you are searching for.</td>
</tr>
<tr>
<td>SWI14</td>
<td>Workflows for Object</td>
</tr>
<tr>
<td></td>
<td>Use this if you want to get all of the workflows that have a common PCO class.</td>
</tr>
</tbody>
</table>

**Note**

The PCO class that is used by your process is configured in Customizing under *Environment, Health, and Safety > Foundation for EHS > Process Foundation > Specify Process Definitions*. 
11.1.1.1.4 Process Logs on the User Interface

In most places where Environment, Health, and Safety uses workflows in the application, you can access the process progress log for this workflow easily from the user interface. You can access the log in the following ways:

- Choose the See Also menu to access the progress log for the underlying process.
- Select the status link for a process.

If your user is authorized to use the process tools, you can see pushbuttons on the progress log that take you to the more technical logs. For more information about the required authorizations, see the Environment, Health, and Safety specific information in the Security Guide for SAP S/4HANA at the SAP Help Portal under help.sap.com/s4hana_op_1610_002 [Product Documentation].

11.1.1.2 Tracing BOPF Data

You can use the BOPF data trace to analyze the runtime behavior of BOs. It can be configured to trace the data that flows through certain interfaces between BOPF and its environment. Traces are configured for the following flows of data:

- Service Provider <-> BOPF
- BOPF <-> Buffer
- Buffer Dispatcher <-> Node Buffers (if applicable)
- Buffer <-> Data Access (if applicable)
- BOPF <-> Association, Action, Determination, Query, Validation

Trace Configuration

To configure traces in the Business Object Processing Framework (transaction BOBF), proceed as follows:

- In the menu under Utilities Settings select the checkbox System Browser and save your entry.
- In the added System Browser option, select Application Flow & Data Trace under Runtime Tools.
- Open the context menu by clicking the right-hand mouse button and select Maintain Trace Settings. Note that you can switch the trace on for different interfaces, specified users, and specified BOs.

⚠️ Caution
Activating a blank user name activates the trace for all users. Activating a blank BO name activates the trace for all BOs. Do not activate the trace for all users and for all BOs.

After activation, the tool writes trace data until it is deactivated. You should deactivate all of your traces after recording.

-reaching 1.

Note
The trace does not work for a BO that is already in use at the time when you activate the trace.
Trace Analysis

To analyze or view the traces directly in the Business Object Processing Framework (transaction BOBF), proceed as follows:

- In the menu under Utilities ➤ Settings select the checkbox System Browser and save your entry.
- In the added System Browser option, select the user for whom you want to view traces in Application Flow & Data Trace under Runtime Tools.
- Open the context menu by clicking the right-hand mouse button and select Display Trace.

11.1.1.1.3 Overview of Application Log Objects

The following table contains all the objects and subobjects that are used for the application log in Environment, Health, and Safety.

Table 21: List of Log Objects and Subobjects

<table>
<thead>
<tr>
<th>Log Object</th>
<th>Log Subobject</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EHFND_FW (Foundation for EHS)</td>
<td>GENERAL</td>
<td>General messages for the foundation for EHS</td>
</tr>
<tr>
<td></td>
<td>UI_COMMUNICATION</td>
<td>UI communication.</td>
</tr>
<tr>
<td></td>
<td>WF_SCHEDULER</td>
<td>The General Scheduler Log displays information about the executions of the scheduler, which scheduled process instances were executed, and which had errors.</td>
</tr>
<tr>
<td></td>
<td>WF_SCHEDULER_ITEM</td>
<td>The Scheduler Item Log displays detailed information about the execution of scheduled process instances with detailed error information in case of errors.</td>
</tr>
<tr>
<td>EHFND_INTEGRATION (Integration Framework)</td>
<td>EHFND_EXT_NOTIF</td>
<td>Log for notifications to integrated systems, such as PM.</td>
</tr>
<tr>
<td>EHHSS_BO_INC (Incident Management)</td>
<td>EHHSS_AIF_INC_INBD</td>
<td>Log for inbound processing of SAP Interactive Forms by Adobe in the incident application.</td>
</tr>
<tr>
<td></td>
<td>EHHSS_HR_ABS</td>
<td>Log for HR absence notifications.</td>
</tr>
<tr>
<td>EHHSS_BO_RAS (Risk Assessment)</td>
<td>EHHSS_AIF_RAS_INBD</td>
<td>Log for inbound processing of SAP Interactive Forms by Adobe in the risk assessment application.</td>
</tr>
<tr>
<td>EHHSS_BO_HSP</td>
<td>EHHSS_RPT_HSP</td>
<td>Log for the batch report which sends health surveillance protocol proposals to occupational health.</td>
</tr>
<tr>
<td>EHFND_REP_FILL (Chemical)</td>
<td>FILL_CHM_BY_EHS_SUB</td>
<td>Log for the batch report which transfers chemical substances from EHS Management as part of SAP ERP.</td>
</tr>
<tr>
<td></td>
<td>FILL_CHM_PHRASES</td>
<td>Log for the batch report which transfers phrases used in the chemical substances.</td>
</tr>
<tr>
<td></td>
<td>FILL_REGL_BY_EHS_SUB</td>
<td>Log for the batch report which transfers regulatory lists.</td>
</tr>
<tr>
<td>EHVENV_EMIS (Environment Management)</td>
<td>AUTO_MDEF_CHECK</td>
<td>Scheduler job log for missing and due amounts.</td>
</tr>
</tbody>
</table>
11.1.1.4  Tasks - Notifications to Integrated Systems

The system documents all notifications for tasks that are sent to integrated systems in the application log. You can display the created plant maintenance notifications in transaction IW23 (Display PM Notification).

11.1.2  Specific Management Tools for EHS

SAP provides you with infrastructure to help your technical support consultants and system administrators effectively manage all SAP components and complete all tasks related to technical administration and operation. The following sections provide information about managing Environment, Health, and Safety. For more generic information, see Management of SAP S/4HANA [page 10] in the Getting Started section.

11.1.2.1  List of Administration Tools

The following tools are especially relevant to Environment, Health, and Safety.

<table>
<thead>
<tr>
<th>Software Component</th>
<th>Transaction / Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOPF (Business Object Processing Framework)</td>
<td>BOBT</td>
<td>Test UI for BOPF. For analysis and change to the runtime data stored in business objects.</td>
</tr>
<tr>
<td></td>
<td>BOB</td>
<td>Customization UI for BOPF. For analysis and enhancements of the structure/definition of business objects.</td>
</tr>
<tr>
<td>POWL, Work Inbox, Task Management</td>
<td>POWL_ADMIN_COCKPIT</td>
<td>This report is a single point of entry to perform different administrator activities relevant for personal object worklist (POWL) development, Customizing, and testing.</td>
</tr>
<tr>
<td></td>
<td>POWL_D01</td>
<td>You can use this report to delete derived administration queries and user-defined queries. You might want to use the deletion report if administration queries have been changed, but the user has already received a derivation of the old version.</td>
</tr>
<tr>
<td></td>
<td>POWL_D03</td>
<td>Check Consistency of POWL Table Entries.</td>
</tr>
<tr>
<td>Software Component</td>
<td>Transaction / Tool</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>POWL_D04</td>
<td>Delete Cached Selection Criteria for Admin Queries.</td>
</tr>
<tr>
<td></td>
<td>POWL_D07</td>
<td>Delete Shadowing Entries: This report deletes derived or user-defined POWL queries created in shadowing mode from the cache, based on application ID or user.</td>
</tr>
<tr>
<td></td>
<td>POWL_WLOAD</td>
<td>Refresh Active POWL Queries: You can use this report to update queries. If you schedule the report as a background job, for example, you can update the queries overnight. Users then have access to the updated data when they start work, without having to refresh the data themselves. This is a way of controlling the server load.</td>
</tr>
<tr>
<td>Process Setup, Process Scheduler</td>
<td>Report R_EHFND_PSE_DISABLE_ENTRY</td>
<td>The report allows you to disable one entry by providing the ID of the respective process setup as the parameter. The ID of the entry can be found in one of the messages in the scheduler log.</td>
</tr>
<tr>
<td></td>
<td>Report R_EHFND_PSE_DISABLE_ERONEOUS</td>
<td>The report allows you to disable all entries that have had more than a given number of errors since a given date.</td>
</tr>
<tr>
<td>Process Foundation</td>
<td>EHFND_WFF_GRAPH_WFLG</td>
<td>The Graphical Workflow Log enables you to open the graphical workflow log with the ID of a work item or workflow.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_PRCDEF_CHK</td>
<td>The Process Definition Check runs several checks on a process definition.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_PRCDEF_INF</td>
<td>The Process Definition Information displays detailed technical information about a process definition.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_PRCDEF_LST</td>
<td>The Process Definition List shows the process definitions from the process definitions table (EHFND_PROCDEF).</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_PROCS_CHK</td>
<td>The Process Instance Check runs several checks on a process instance.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_PROCS_INF</td>
<td>The Process Instance Information displays detailed technical information about a process instance.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_PROCS_LST</td>
<td>The Process Instance List shows process instances for a given process.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_SYSTEM_CHK</td>
<td>The Process System Check runs several checks to see if the system has been correctly setup to use the process foundation.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_TECH_WFIBO</td>
<td>The Technical Workflow Inbox displays the work items of a given user with technical information.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_TECH_WFLOG</td>
<td>The Technical Workflow Log allows direct access to the technical workflow log using ID of a work item or workflow instance.</td>
</tr>
</tbody>
</table>
### 11.1.1.2.2 Data Archiving

For archiving data, *Environment, Health, and Safety* uses the data archiving function within *SAP S/4HANA*. *Environment, Health, and Safety* provides configuration for the following archiving objects:

<table>
<thead>
<tr>
<th>Archiving Object</th>
<th>Description</th>
<th>Archived Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>EHHSS_INC</td>
<td>EHS Incidents</td>
<td>Data of the <em>Incident</em> business object</td>
</tr>
<tr>
<td>EHHSS_ISR</td>
<td>EHS Incident Summary Reports</td>
<td>Data of incident summary reports</td>
</tr>
<tr>
<td>EHHSS_RSV</td>
<td>Risks Revisions</td>
<td>Data records of risk revisions (partial archiving)</td>
</tr>
<tr>
<td>EHHSS_RSK</td>
<td>Risks</td>
<td>Data records of risks</td>
</tr>
<tr>
<td>EHHSS_RAS</td>
<td>Risks Assessments</td>
<td>Data records of risk assessments</td>
</tr>
<tr>
<td>EHHSS_SI</td>
<td>Safety Instructions</td>
<td>Data records of safety instructions</td>
</tr>
<tr>
<td>EHHSS_CEVL</td>
<td>Control Evaluations</td>
<td>Data records of control evaluations</td>
</tr>
<tr>
<td>EHHSS_CINS</td>
<td>Control Inspections</td>
<td>Data records of control inspections</td>
</tr>
<tr>
<td>EHHSS_CRPL</td>
<td>Control Replacements</td>
<td>Data records of control replacements</td>
</tr>
<tr>
<td>EHHSS_SPLC</td>
<td>Sampling Campaigns</td>
<td>Data records of sampling campaigns</td>
</tr>
<tr>
<td>EHFND_SPLG</td>
<td>Samplings</td>
<td>Data records of samplings</td>
</tr>
<tr>
<td>EHFND_CHA</td>
<td>Chemical Approvals</td>
<td>Data records of chemical approvals</td>
</tr>
</tbody>
</table>

#### Note

To execute the transactions for the process foundation, the PFCG role assigned to your user requires the authorization object EHFND_WFT with activity 16 and the transaction names. This also authorizes you to access these back-end transactions from the front end, for example, from the process progress log UI.
Archiving Object | Description | Archived Data
--- | --- | ---
EHFND_LOCP | Assignments of Persons to Locations | Data records of persons who are assigned to locations
EHFND_JOBP | Assignments of Persons to Jobs | Data records of persons who are assigned to jobs
EHENV_SAC | EHS Environmentally-related tasks | Tasks of category Action

All archiving objects comply with the rules of SAP Information Lifecycle Management (ILM). You can activate ILM in the Switch Framework (transaction SFW5).

Form more generic information, see Data Archiving and Data Aging [page 13].

### 11.1.1.2.3 Scheduling of Periodic Tasks

You have to run the following job periodically in order to keep Environment, Health, and Safety running smoothly over time.

Table 24: Job Details

<table>
<thead>
<tr>
<th>Program Name/Task</th>
<th>Recommended Frequency</th>
<th>Detailed Description</th>
</tr>
</thead>
</table>

If you have enabled integration into other applications, you have to run the following jobs periodically.

Table 25: List of Jobs

<table>
<thead>
<tr>
<th>Program Name/Task</th>
<th>Recommended Frequency</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>R_EHFND_CHECK_COMPL_EXT_NOTIF</td>
<td>Daily</td>
<td>See Customizing activity Schedule Job for Notification Status Check (EHFND_CHECK_COMP_NOT)</td>
</tr>
<tr>
<td>R_EHFND_SYNCEAM_LOCATION</td>
<td>Daily</td>
<td>See Customizing activity Schedule Jobs for Location Synchronization (EHFND_LOC_SYNCEAM)</td>
</tr>
<tr>
<td>R_EHHSS_CHECK_HCM_ABS_CHANGED</td>
<td>Daily</td>
<td>See Customizing activity Schedule Jobs for HR Absence Check (EHHSS_CHECK_HR_ABS)</td>
</tr>
<tr>
<td>R_EHHSS_PROPOSE_HSPROTocols</td>
<td>Daily</td>
<td>See Customizing activity Schedule Job for Proposing Health Surveillance Protocols (EHHSS_PROP_HSPROT)</td>
</tr>
</tbody>
</table>
### Transferring Data

#### Transferring Incident Data

You can transfer incident data between Environment, Health, and Safety (EHS) systems or between an Environment, Health, and Safety system and a component extension for SAP EHS Management (release 3.0 or higher) system. In addition, you can import incident data from non-SAP systems to an Environment, Health, and Safety system.

For more information about transferring incident data between SAP systems or importing incident data from non-SAP systems, see information about Incident Management at the SAP Help Portal under help.sap.com/s4hana_op_1610_002. Open the product assistance and go to the section on Environment, Health, and Safety.

#### Transferring Specification Data

You can use three reports to transfer chemical data from the specification database of SAP EHS Management as part of SAP ERP or of Product Safety and Stewardship as part of SAP S/4HANA to the Environment, Health, and Safety system for use in health and safety management.

For more information about transferring data from the specification database, see the section Managing Chemicals for Health and Safety Processes at the SAP Help Portal under help.sap.com/s4hana_op_1610_002. Open the product assistance and go to the section on Environment, Health, and Safety.
11.1.1.3 Specific Troubleshooting for EHS

The following sections provide information about troubleshooting and error handling for Environment, Health, and Safety
For general information, see Troubleshooting [page 18].

11.1.1.3.1 Troubleshooting the Process Foundation

Since the process foundation is responsible for implementing your business processes in the system, it may be directly related to problems or problems may be found by analyzing the information available through the process foundation.

Problem: A Process Did Not Start

You can perform the following steps to troubleshoot this problem:
1. Make sure that the process did not really start. Processes that you can schedule may sometimes be delayed even if they are scheduled to run immediately because the process scheduler executes these processes. For more information, see section Process Setup and Scheduled Processes.
2. Ensure that a short dump did not occur in transaction ST22.
3. Use transaction EHFND_WFF_PROCS_LST to search for the instance.
4. If you cannot find the instance there, it may be that the system has not yet established the linkage between the workflow and the PCBO. Usually, this linkage occurs during the call of the START_PROCESSING action of the PCBO through the workflow system. If this call fails or cannot successfully be finished (maybe the PCBO or another important component is currently locked and therefore the process has to wait), you may still find the process by searching for it in transaction SWI14. Note that you will need the name of the PCO class to use this transaction.
5. If you cannot find the process instance, there may be a problem with the system or the process definition.
6. Check if the system is correctly set up for using the process foundation of EHS by executing transaction EHFND_WFF_SYSTEM_CHK.
7. If the system is set up correctly, check the process by executing transaction EHFND_WFF_PRCDEF_CHK for the process definition, or checking the status of the process definition in EHFND_WFF_PRCDEF_LST. The system provides information about possible problems.
8. If none of the above helped, you can also look at the event queue browser of SAP Business Workflow (transaction SWEQBROWSER), or the event queue administrator (transaction SWEQADM_1) and check if there were any events that could not be delivered.

Problem: Process Stopped

If a process stopped, you can perform the following steps:
1. Ensure that a short dump did not occur in the workflow execution. The workflow cannot catch these dumps and is not able to recognize that a problem has occurred. You can check for short dumps by analyzing transaction ST22.
2. If a short dump did not occur, execute transaction EHFND_WFF_PROCS_CHK either directly, or by selecting the Checkicon for your process in transaction EHFND_WFF_PROCS_LST. The system runs several checks on the instance and may give you information about what caused the problem.

3. If you still cannot find the problem, you can analyze the workflow log for your process. You can launch the workflow log, for example, from transaction EHFND_WFF_PROCS_LST by choosing the Logicon for the respective row.

The following information might be helpful when you troubleshoot the problem:

- Are there any problems with the agent assignment?
  Perhaps the work item could not be assigned to a user.

- Is there any information in the step details of the workflow instance or one of the work items?
  Maybe the workflow is just waiting because the object it is trying to change is currently locked.

### Problem: Inconsistent Data

If a workflow or a PCBO instance has been deleted and the other part is still in the system, you can use report R_EHFND_WFF_CORRECT_PCBOS to correct inconsistencies.

#### 11.1.1.3.2 Process Setup and Scheduled Processes

Processes that can be scheduled, for example, the processes that you start on the Tasks tab in the application are not created directly after you choose the Start Process pushbutton; they are launched by the Environment, Health, and Safety process scheduler. The scheduler is integrated into the process setup business object when they are due for execution. To avoid problems, ensure that you have activated the event type linkage for scheduled processes. For more information, see Customizing for Environment, Health, and Safety under [Foundation for EHS] > [Process Foundation] > [Processes] > [Activate Linkage for Scheduled Processes].

Almost all problems that could occur on execution will be reported in the application log (transaction SLG1) for the scheduler log objects. For more information, see [Overview of Application Log Objects] [page 54].

If there are problems with a scheduled process and the system executes it more than once, you can use reports to disable them. For more information, see [List of Administration Tools] [page 55].

For Environment Management, you can see performance information for the processes of automated data collection and automatic calculations of environmental data. For more detailed information, see SAP Note 2371803.

#### 11.1.1.3.3 Form Generation with Adobe Document Services

To gain comprehensive information about how to troubleshoot the form generation with Adobe Document Services, see SAP Note 944221.
11.1.3.4  Notifications to Integrated Systems

If there are problems with the notification processes to integrated systems, you should first make sure that the process itself is working correctly. See the steps in the section Troubleshooting the Process Foundation [page 60].

If you are sure that there are no problems with the process, check the monitoring transactions for notifications. For more information, see the section Tasks - Notifications to Integrated Systems [page 55].

Pay special attention to the requirements of these notifications as described in the Customizing for Environment, Health, and Safety under [Foundation for EHS] Integration Specify Notification Types.

11.1.4  Support Desk Management for EHS

If issues arise when using SAP software, you can get in contact with the SAP support desk.

For general information about SAP support, see Support Desk Management [page 19].

For sending problem messages/tickets for Environment, Health, and Safety to SAP, choose one of the following components (or subcomponents) from the SAP component hierarchy.

- EHS-MGM (EHS Management)
  - EHS-MGM-FND (Foundation for EHS Management)
  - EHS-MGM-INC (Incident Management)
  - EHS-MGM-ENV (Environment Management)
  - EHS-MGM-RAS (Risk Assessment / Health and Safety Management)

Note

For Environment, Health, and Safety, the same application components are applicable as for component extension for SAP EHS Management.

11.2  Cross Applications

This section of the Operations Guide for SAP S/4HANA contains information on operations tasks specific to Cross Applications.

11.2.1  Master Data Governance

This section of the Operations Guide for SAP S/4HANA contains information on operations tasks specific to MDG.
11.2.1.1 Interfaces

Interfaces use monitor tools that are essential for analyzing problems.

Table 26

<table>
<thead>
<tr>
<th>Interface</th>
<th>Monitor</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DRF</td>
<td>DRFLOG</td>
<td>Data Replication Log (SAP GUI)</td>
</tr>
<tr>
<td>DRF</td>
<td>DRFRSD</td>
<td>Display Object Replication Status (SAP GUI)</td>
</tr>
<tr>
<td>DRF</td>
<td>MDG_BS_WD_RSI_DISPLAY</td>
<td>Display Replication Status Information (Web Dynpro application)</td>
</tr>
<tr>
<td>Key Mapping</td>
<td>MDG_ANALYSE_IDM</td>
<td>Display/Search for Key Mapping (SAP GUI)</td>
</tr>
<tr>
<td>Key Mapping</td>
<td>MDG_BS_WD_ANALYSE_IDM</td>
<td>Display/Search for Key Mapping (Web Dynpro application)</td>
</tr>
<tr>
<td>Data Transfer</td>
<td>MDG_BS_DL_MONITOR_CONF</td>
<td>Data Transfer Monitor (Web Dynpro application)</td>
</tr>
</tbody>
</table>

11.2.1.2 Change Request Analysis

You can analyze change requests in the following ways:

- **Check how Quickly Change Requests are being Processed**
  For any time frame or change request priority, you can quickly identify the extent to which change requests comply with or violate target processing times. If you enable dashboards, you can view this information in an interactive graphical format.

- **Check the Status of Change Requests**
  For any time frame or change request priority, you can get a summary of the numbers of change requests completed and rejected, completed and accepted, and created. You can also get a summary of rejection reasons.

- **Assess your own Involvement with Change Requests**
  For change requests involving you, you can view a graphical summary of the nature of your involvement in a side panel.

- **MDG Track My Requests App**
  With the transactional app MDG Track My Requests, you can display all of your master data requests.

11.2.1.3 Scheduled Periodic Tasks

This section describes all automatable tasks required to run periodically in order to keep the application running smoothly over time. Such tasks may be required on component level and are therefore relevant in each scenario that uses the component. Other tasks may be relevant for certain business scenarios only. It is important that you monitor the successful execution of these tasks on a regular basis.

For MDG, you can plan a periodic report RBDMIDOC to trigger ALE outbound tasks based on change pointers.
Scheduled Periodic Tasks for Master Data Governance

Table 27

<table>
<thead>
<tr>
<th>Program Name/Task</th>
<th>Recommended Frequency</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DRFLOGDEL (RDRF_DELETE_LOG)</td>
<td>Weekly. More often, if high number of objects are replicated within a week</td>
<td>Deletes the application log data written by DRF as well as DRF internal log information</td>
</tr>
<tr>
<td>DRFRSDEL (RDRF_DELETE_REP_STA)</td>
<td>Same as DRFLOGDEL</td>
<td>Deletes the replication status information, but keeps the last record and the last successful record for each object instance/target system</td>
</tr>
<tr>
<td>MDGCPDEL (MDG_BS_CHANGE_POINTER_TOOLS)</td>
<td>Different for each object type; depends on whether change pointers are written at all and if yes, how many.</td>
<td>Deletes processed change pointers and by special request, also newly created ones.</td>
</tr>
<tr>
<td>DRFOUT</td>
<td>Depends on business case</td>
<td>Execution of data replication; DRFOUT can be used for manual replication as well as for regular planned deferred replication by using change pointers</td>
</tr>
<tr>
<td>USMD_EDITION_REPLICATE</td>
<td>On or shortly after the valid-from date (or period) for changes to the relevant business objects</td>
<td>Ensures the timely replication of changes to edition-based business objects belonging to a data model in cases where the target system does not support time dependency for the relevant business objects.</td>
</tr>
</tbody>
</table>

11.2.1.4 Load Balancing

MDG uses the bgRFC (Background Remote Function Call) to schedule background processing and to parallelize data processing in process steps. MDG also uses bgRFC Configuration for distributing the processing load in systems.

Table 28

<table>
<thead>
<tr>
<th>Scenarios</th>
<th>Detailed Description</th>
<th>Tools To Be Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Replication with DRF using transaction DRFOUT</td>
<td>The report allows you to define settings for parallel processing.</td>
<td>Data Replication with DRF, using transaction DRFOUT</td>
</tr>
<tr>
<td>Data Export and Data Import</td>
<td>Both data export and data import can be started with multiple parallel processes.</td>
<td>Data Export and Data Import</td>
</tr>
</tbody>
</table>
11.2.1.5 Virus Scan Profile for MDG Request Applications

The virus scan profile MDG_BS_FILE_UPLOAD/MDG_VSCAN is used when uploading files to the MDG Request applications.

11.3 Finance

This section of the Operations Guide for SAP S/4HANA contains information about operation tasks specific to Finance.

Archiving and Data Aging

Archiving

For information about archiving in Finance, see Enterprise Technology at the SAP Help Portal under help.sap.com/s4hana_op_1610_002 ➥ Product Assistance.

Data Aging

To use Data Aging, proceed as follows:
1. Activate Data Aging by entering the profile parameter abap/data_aging in the database.
2. Activate the Data Aging business function DAAG_DATA_AGING using the switch framework (transaction SWF5).
3. Partition the database tables for aging (transaction DAGPTM).
4. Activate aging object FI_DOCUMENT.
5. Maintain the residence time in Customizing for data object FI_DOCUMENT according to company code, account types, and document types.

For more information, see also Data Archiving and Data Aging [page 13]
12 SAP S/4HANA LoB Products for specific industries

SAP S/4HANA LoB Products for specific industries enhance core functions of SAP S/4HANA Enterprise Management to provide industry specific business benefit for your line of business (LoB). Please note that you might need a separate license. For further information, please contact your SAP Account Executive.
13 SAP S/4HANA Compatibility Packs

This section of the Operations Guide for SAP S/4HANA contains specific operations information for the functionality included in SAP S/4HANA Compatibility Packs.

13.1 R&D / Engineering

This section of the Operations Guide for SAP S/4HANA contains information on operations tasks specific to R&D / Engineering.

13.1.1 Product Safety and Stewardship

This section contains operations information about Product Safety and Stewardship for:

- Product Compliance
- Process Industries

13.1.1.1 Product Safety and Stewardship for Product Compliance

This section contains information for Product Safety and Stewardship valid for Product Compliance for Discrete Industries

13.1.1.1.1 Specific Monitoring Tools for Product Compliance

Monitoring is essential to running and managing SAP technology. The following sections provide information about monitoring specifically for Product Compliance for Discrete Industries. For more generic information, see Monitoring [page 8].

13.1.1.1.1 Trace and Log Files for Product Compliance

Trace files and log files are essential for analyzing problems.
SAP Business Workflow Log

You can use the workflow log to inspect workflow instances. You can use either the standard view for end-users or the technical view. The technical view contains additional options for developers and administrators, such as inspecting workflows and work item containers.

To access the workflow log, you can use the following standard transactions to find a workflow:

Table 29: Transaction Details

<table>
<thead>
<tr>
<th>Transaction</th>
<th>Description</th>
</tr>
</thead>
</table>
| SWI6        | Workflows for Object  
Use this if you know the ABAP class and key of the PCO that is related to the workflow that you are searching for. |
| SWI14       | Workflows for Object  
Use this if you want to get all of the workflows that have a common PCO class. |

Note

The PCO class that is used by your process is configured in Customizing under Product Safety and Stewardship > Product Compliance for Discrete Industries > Foundation for Product Compliance > Process Foundation > Specify Process Definitions.

Process Logs on the User Interface

In most places where Product Compliance for Discrete Industries uses workflows in the application, you can access the process progress log for this workflow easily from the user interface. You can access the log in the following ways:

- Choose the See Also menu to access the progress log for the underlying process.
- Select the status link for a process.

If your user is authorized to use the process tools, you can see pushbuttons on the progress log that take you to the more technical logs. For more information about the required authorizations, see the Product Compliance for Discrete Industries specific information in the Security Guide for SAP S/4HANA at the SAP Help Portal under help.sap.com/s4hana_op_1610_002 > Product Documentation.

Tracing BOPF Data

You can use the BOPF data trace to analyze the runtime behavior of BOs. It can be configured to trace the data that flows through certain interfaces between BOPF and its environment. Traces are configured for the following flows of data:

- Service Provider <-> BOPF
- BOPF <-> Buffer
- Buffer Dispatcher <-> Node Buffers (if applicable)
- Buffer <-> Data Access (if applicable)
- BOPF <-> Association, Action, Determination, Query, Validation
• Association, Action, Determination, Query, Validation \(\leftrightarrow\) Internal Access (io_read, io_modify, io_check, io_query).

**Trace Configuration Concept Tags**

To configure traces in the *Business Object Processing Framework* (transaction BOBF), proceed as follows:

- In the menu under \(\rightarrow\) **Utilities** \(\rightarrow\) **Settings** select the checkbox **System Browser** and save your entry.
- In the added **System Browser** option, select **Application Flow & Data Trace** under **Runtime Tools**.
- Open the context menu by clicking the right-hand mouse button and select **Maintain Trace Settings**. Note that you can switch the trace on for different interfaces, specified users, and specified BOs.

**Caution**

Activating a blank user name activates the trace for all users. Activating a blank BO name activates the trace for all BOs. Do not activate the trace for all users and for all BOs.

After activation, the tool writes trace data until it is deactivated. You should deactivate all of your traces after recording.

**Note**

The trace does not work for a BO that is already in use at the time when you activate the trace.

**Trace Analysis**

To analyze or view the traces directly in the *Business Object Processing Framework* (transaction BOBF), proceed as follows:

- In the menu under \(\rightarrow\) **Utilities** \(\rightarrow\) **Settings** select the checkbox **System Browser** and save your entry.
- In the added **System Browser** option, select the user for whom you want to view traces in **Application Flow & Data Trace** under **Runtime Tools**.
- Open the context menu by clicking the right-hand mouse button and select **Display Trace**.

**Overview of Application Log Objects**

The following table contains all the objects and subobjects that are used for the application log in *Product Compliance for Discrete Industries*.

<table>
<thead>
<tr>
<th>Log Object</th>
<th>Log Subobject</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EHFND_FW (Foundation for Product Compliance)</td>
<td>GENERAL</td>
<td>General messages for the foundation for EHS</td>
</tr>
<tr>
<td></td>
<td>UI_COMMUNICATION</td>
<td>UI communication.</td>
</tr>
<tr>
<td></td>
<td>WF_SCHEDULER</td>
<td>The General Scheduler Log displays information about the executions of the scheduler, which scheduled process instances were executed, and which had errors.</td>
</tr>
<tr>
<td></td>
<td>WF_SCHEDULER_ITEM</td>
<td>The Scheduler Item Log displays detailed information about the execution of scheduled process instances with detailed error information in case of errors.</td>
</tr>
</tbody>
</table>
## 13.1.1.1.2 Workload Monitors for Product Compliance

### Monitoring the Workflow and Process Foundation

The process foundation is essential to the business process of Product Compliance for Discrete Industries. It links together the SAP Business Workflow engine and the BOFF business objects of Product Compliance for Discrete Industries.

You can monitor the processes with the following process tools:

- EHFND_WFF_PRCDEF_LST
- EHFND_WFF_PROCS_LST
- EHFND_WFF_TECH_WFIBO

### Monitoring Scheduled Processes

The process scheduler of Product Compliance for Discrete Industries is used for recurring tasks and planned execution of a process instance. You can use the following transactions to monitor the scheduled processes:

<table>
<thead>
<tr>
<th>Log Object</th>
<th>Log Subobject</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EHPRC_CP_CORE (Product Compliance Core)</td>
<td>AUTO_CHANGE_PROC</td>
<td>Log for the automated change processing</td>
</tr>
<tr>
<td></td>
<td>WORKLIST</td>
<td>Log for worklists</td>
</tr>
<tr>
<td></td>
<td>IMDS</td>
<td>Log for IMDS processing</td>
</tr>
<tr>
<td></td>
<td>CPRVDR</td>
<td>Log for Content Provider</td>
</tr>
<tr>
<td></td>
<td>CUSTOMIZING</td>
<td>Log for Customizing</td>
</tr>
<tr>
<td></td>
<td>EMAIL</td>
<td>Log for Email Processing</td>
</tr>
<tr>
<td></td>
<td>BOMBOS</td>
<td>Log for BOMBOS</td>
</tr>
<tr>
<td>EHPRC_PFR (Product Compliance - Spreadsheet)</td>
<td>ADMIN</td>
<td>Log for Administrators</td>
</tr>
<tr>
<td></td>
<td>DEV</td>
<td>Log for Developers</td>
</tr>
<tr>
<td>EHPRC_PFR (Product Compliance - Spreadsheet Report)</td>
<td>ADMIN</td>
<td>Log for Administrators</td>
</tr>
<tr>
<td></td>
<td>DEV</td>
<td>Log for Developers</td>
</tr>
<tr>
<td></td>
<td>PFR_BGR</td>
<td>Log for Background Spreadsheet Reporting</td>
</tr>
<tr>
<td>EHPRC_SCC (Product Compliance - Supply Chain Collaboration)</td>
<td>ADMIN</td>
<td>Log for Administrators</td>
</tr>
</tbody>
</table>
Table 31: Transaction Details

<table>
<thead>
<tr>
<th>Transaction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLG1</td>
<td>Application log</td>
</tr>
<tr>
<td>SM37</td>
<td>Job log</td>
</tr>
</tbody>
</table>

The scheduler uses a self-rescheduling job to do its work. In addition to the application log, you can also find information about the scheduler executions in this transaction.

To display only the jobs related to the Product Compliance for Discrete Industries scheduler, you can filter by job name R_EHFND_SCHEDULER_JOB. In addition, you should change the user name parameter to "*" (asterisk) as the jobs are always run under the last user that created a scheduler entry.

For more information about the log objects for the scheduler, see section *Overview of Application Log Objects*.

### Monitoring Automated Change Processing

The automated change processing handles relevant changes of compliance data automatically. As long as the affected compliance data is not up to date, it is considered to be pending. The monitoring application shows all pending records and the number of attempts to execute an entry. In case of problems, the user can view the application log for the errors that have occurred.

You can access this monitoring in the application under *Product Safety and Stewardship → Compliance Worklists → Monitor Changes to Compliance Information*.

### Monitoring Campaigns for Product Compliance

Campaigns are used to collate and organize communication with business partners. The monitoring application shows the status of a campaign and of tasks that have been started for the campaign. You can change administrative data, send reminders, send requests, and complete a campaign.

You can access this monitoring in the application under *Product Safety and Stewardship → Supply Chain Collaboration → Search Campaigns*.

### 13.1.1.1.3 Data Consistency

Data can be inconsistent when related or identical data is stored in multiple places, for example, after you restore a single component. The following table describes how you can verify consistency and how you can repair inconsistencies.
Table 32

<table>
<thead>
<tr>
<th>Component / Data Storage</th>
<th>Check Tool / Method</th>
<th>Detailed Description</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCBO &lt;-&gt; Business Workflow</td>
<td>Report R_EHFND_WFF_CORRECT_PC BOS</td>
<td>For more information, see the report documentation.</td>
<td>You have set up the process system correctly, including the process definitions in Customizing under Environment, Health, and Safety Foundation for EHS Process Foundation Specify Process Definitions.</td>
</tr>
</tbody>
</table>

13.1.1.2 Specific Management Tools for Product Compliance

SAP provides you with infrastructure to help your technical support consultants and system administrators effectively manage all SAP components and complete all tasks related to technical administration and operation. The following sections provide information about managing Product Compliance for Discrete Industries. For more generic information, see Management of SAP S/4HANA [page 10].

13.1.1.2.1 List of Administration Tools

The following tools are especially relevant to Product Compliance for Discrete Industries.

Table 33: List of Administration Tools

<table>
<thead>
<tr>
<th>Software Component</th>
<th>Transaction / Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOPF (Business Object Processing Framework)</td>
<td>BOBT</td>
<td>Test UI for BOPF. For analysis and change to the runtime data stored in business objects.</td>
</tr>
<tr>
<td></td>
<td>BOB</td>
<td>Customization UI for BOPF. For analysis and enhancements of the structure/definition of business objects.</td>
</tr>
<tr>
<td>POWL, Work Inbox, Task Management</td>
<td>POWL_ADMIN_COCKPIT</td>
<td>This report is a single point of entry to perform different administrator activities relevant for personal object worklist (POWL) development, Customizing, and testing.</td>
</tr>
<tr>
<td></td>
<td>POWL_D01</td>
<td>You can use this report to delete derived administration queries and user-defined queries. You might want to use the deletion report if administration queries have been changed, but the user has already received a derivation of the old version.</td>
</tr>
<tr>
<td></td>
<td>POWL_D03</td>
<td>Check Consistency of POWL Table Entries.</td>
</tr>
<tr>
<td>Software Component</td>
<td>Transaction / Tool</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>POWL_D04</td>
<td>Delete Cached Selection Criteria for Admin Queries.</td>
<td></td>
</tr>
<tr>
<td>POWL_D07</td>
<td>Delete Shadowing Entries: This report deletes derived or user-defined POWL queries created in shadowing mode from the cache, based on application ID or user.</td>
<td></td>
</tr>
<tr>
<td>POWL_WLOAD</td>
<td>Refresh Active POWL Queries: You can use this report to update queries. If you schedule the report as a background job, for example, you can update the queries overnight. Users then have access to the updated data when they start work, without having to refresh the data themselves. This is a way of controlling the server load.</td>
<td></td>
</tr>
<tr>
<td>Report R_EHFND_PSE_DISABLE_ENTRY</td>
<td>The report allows you to disable one entry by providing the ID of the respective process setup as the parameter. The ID of the entry can be found in one of the messages in the scheduler log.</td>
<td></td>
</tr>
<tr>
<td>Report R_EHFND_PSE_DISABLE_ERONEOUS</td>
<td>The report allows you to disable all entries that have had more than a given number of errors since a given date.</td>
<td></td>
</tr>
<tr>
<td>Process Foundation</td>
<td>EHFND_WFF_GRAPH_WFLG</td>
<td>The Graphical Workflow Log enables you to open the graphical workflow log with the ID of a work item or workflow.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_PRCDEF_CHK</td>
<td>The Process Definition Check runs several checks on a process definition.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_PRCDEF_INF</td>
<td>The Process Definition Information displays detailed technical information about a process definition.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_PRCDEF_LST</td>
<td>The Process Definition List shows the process definitions from the process definitions table (EHFNDC_PROCDEF).</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_PROCS_CHK</td>
<td>The Process Instance Check runs several checks on a process instance.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_PROCS_INF</td>
<td>The Process Instance Information displays detailed technical information about a process instance.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_PROCS_LST</td>
<td>The Process Instance List shows process instances for a given process.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_SYSTEM_CHK</td>
<td>The Process System Check runs several checks to see if the system has been correctly setup to use the process foundation.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_TECH_WFIBO</td>
<td>The Technical Workflow Inbox displays the work items of a given user with technical information.</td>
</tr>
<tr>
<td></td>
<td>EHFND_WFF_TECH_WFLOG</td>
<td>The Technical Workflow Log allows direct access to the technical workflow log using ID of a work item or workflow instance.</td>
</tr>
</tbody>
</table>
### Software Component

<table>
<thead>
<tr>
<th>Software Component</th>
<th>Transaction / Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>EHFND_WFF_WI_INF</td>
<td>The Technical Information for Work Item displays detailed technical information about a work item and its related process.</td>
</tr>
<tr>
<td></td>
<td>Report R_EHFND_WFF_CORRECT_PCBOS</td>
<td>The report helps to delete/disable PCBOs which are defective.</td>
</tr>
<tr>
<td></td>
<td>Report R_EHFND_WFF_SHOW_TASK_OF_WFID</td>
<td>The report lists all tasks that are used in a workflow template and indicates if they are background tasks.</td>
</tr>
</tbody>
</table>

**Note**

To execute the transactions for the process foundation, the PFCG role assigned to your user requires the authorization object EHFND_WFT with activity 16 and the transaction names. This also authorizes you to access these back-end transactions from the front end, for example, from the process progress log UI.

### 13.1.1.1.2.2 Data Archiving

For archiving data, *Product Compliance for Discrete Industries* makes use of the data archiving function within SAP S/4HANA.

*Product Compliance for Discrete Industries* provides configuration for the following archiving object:

Table 34: Object Details

<table>
<thead>
<tr>
<th>Archiving Object</th>
<th>Description</th>
<th>Archived Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>EHPRC_IMDS</td>
<td>IMDS Documents</td>
<td>Documents attached to IMDS records</td>
</tr>
</tbody>
</table>

For more information, see also Data Archiving and Data Aging [page 13].

### 13.1.1.1.2.3 Scheduling of Periodic Tasks

If you have enabled integration into other applications, you have to run the following jobs periodically in order to keep *Product Compliance for Discrete Industries* running smoothly over time.

Table 35: Periodic Task Details

<table>
<thead>
<tr>
<th>Program Name/Task</th>
<th>Recommended Frequency</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Name/Task</td>
<td>Recommended Frequency</td>
<td>Detailed Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>R_EHPRC_ACP_WORKLIST DETERMINE</td>
<td>After event: SAP_EHPRC_ACP_NEW_CHANGE</td>
<td>See Customizing activity Schedule Jobs for Automated Change Processing (EHPRC_ACP_JOBS)</td>
</tr>
<tr>
<td>R_EHPRC_ACP_WORKLIST_EXECUTE</td>
<td>Every 10 Minutes</td>
<td>See Customizing activity Schedule Jobs for Automated Change Processing (EHPRC_ACP_JOBS)</td>
</tr>
<tr>
<td>R_EHPRC_ACP_WORKLIST_FUTURE_CHANGE</td>
<td>Daily during night</td>
<td>See Customizing activity Schedule Jobs for Automated Change Processing (EHPRC_ACP_JOBS)</td>
</tr>
<tr>
<td>R_EHPRC_SEND_EMAILS</td>
<td>Hourly or even faster</td>
<td>See Customizing activity Schedule Jobs for Supply Chain Collaboration Process (EHPRC_SCC_JOBS)</td>
</tr>
<tr>
<td>R_EHPRC_WL_REGCHG_POST_PROCESS</td>
<td>Daily</td>
<td>See Customizing activity Schedule Jobs for Regulatory List Revision (EHPRC_REGL_WL_JOBS)</td>
</tr>
<tr>
<td>R_EHPRC_IMDS_DOWNLOAD</td>
<td>Daily</td>
<td>See Customizing activity Set Up Daily Synchronization with IMDS (EHPRC_IMDS_SYNC)</td>
</tr>
<tr>
<td>R_EHPRC_IMP_APBPL_BATCH_JOB</td>
<td>Daily</td>
<td>See Customizing activity Set Up Daily Synchronization with IMDS (EHPRC_IMDS_SYNC)</td>
</tr>
<tr>
<td>R_EHPRC_PBB_SUPPL_CHNG_MON</td>
<td>Every 10 Minutes</td>
<td>See Customizing activity Schedule Job for Changes in Supplier and Manufacturer Material Information (EHPRC_PBB_JOBS)</td>
</tr>
</tbody>
</table>

You must schedule jobs specific to Product Compliance for Discrete Industries in your system and, where specified, in all the connected SAP systems. All jobs, unless otherwise specified, should be run at times of minimal system activity, so as not to affect performance or otherwise disrupt your daily operations.

### 13.1.1.1.3 Specific Troubleshooting for Product Compliance

The following sections provide information about troubleshooting and error handling for Product Compliance for Discrete Industries.
13.1.1.3.1 Troubleshooting the Process Foundation

Since the process foundation is responsible for implementing your business processes in the system, it may be directly related to problems or problems may be found by analyzing the information available through the process foundation.

Problem: A Process Did Not Start

You can perform the following steps to troubleshoot this problem:

1. Make sure that the process did not really start. Processes that you can schedule may sometimes be delayed even if they are scheduled to run immediately because the process scheduler executes these processes. For more information, see the Process Setup and Scheduled Processes section.
2. Ensure that a short dump did not occur in transaction ST22.
3. Use transaction EHFND_WFF_PROCS_LST to search for the instance.
4. If you cannot find the instance there, it may be that the system has not yet established the linkage between the workflow and the PCBO. Usually, this linkage occurs during the call of the START_PROCESSING action of the PCBO through the workflow system. If this call fails or cannot successfully be finished (maybe the PCBO or another important component is currently locked and therefore the process has to wait), you may still find the process by searching for it in transaction SWI14. Note that you will need the name of the PCO class to use this transaction.
5. If you cannot find the process instance, there may be a problem with the system or the process definition.
6. Check if the system is correctly set up for using the process foundation of Product Compliance by executing transaction EHFND_WFF_SYSTEM_CHK.
7. If the system is set up correctly, check the process by executing transaction EHFND_WFF_PRCDEF_CHK for the process definition, or checking the status of the process definition in EHFND_WFF_PRCDEF_LST. The system provides information about possible problems.
8. If none of the above helped, you can also look at the event queue browser of SAP Business Workflow (transaction SWEQBROWSER), or the event queue administrator (transaction SWEQADM_1) and check if there were any events that could not be delivered.

Problem: Process Stopped

If a process stopped, you can perform the following steps:

1. Ensure that a short dump did not occur in the workflow execution. The workflow cannot catch these dumps and is not able to recognize that a problem has occurred. You can check for short dumps by analyzing transaction ST22.
2. If a short dump did not occur, execute transaction EHFND_WFF_PROCS_CHK either directly, or by selecting the Checkicon for your process in transaction EHFND_WFF_PROCS_LST. The system runs several checks on the instance and may give you information about what caused the problem.
3. If you still cannot find the problem, you can analyze the workflow log for your process. You can launch the workflow log, for example, from transaction EHFND_WFF_PROCS_LST by choosing the Log icon for the respective row.

The following information might be helpful when you troubleshoot the problem:

- Are there any problems with the agent assignment? Perhaps the work item could not be assigned to a user.
- Is there any information in the step details of the workflow instance or one of the work items? Maybe the workflow is just waiting because the object it is trying to change is currently locked.

**Problem: Inconsistent Data**

If a workflow or a PCBO instance has been deleted and the other part is still in the system, you can use report R_EHFND_WFF_CORRECT_PCBOS to correct inconsistencies.

### 13.1.1.1.3.2 Process Setup and Scheduled Processes

Processes that can be scheduled, for example, the processes that you start on the tasks tab in the application are not created directly after you choose the Start Process pushbutton; they are launched by the Product Compliance for Discrete Industries process scheduler. The scheduler is integrated into the process setup business object when they are due for execution. To avoid problems, ensure that you have activated the event type linkage for scheduled processes. For more information, see Customizing for Product Compliance for Discrete Industries under Foundation Process Foundation Processes Activate Linkage for Scheduled Processes.

Almost all problems that could occur on execution will be reported in the application log (transaction SLG1) for the scheduler log objects. For more information, see the section Overview of Application Log Objects in Trace and Log Files for Product Compliance [page 67].

If there are issues with a scheduled process and the system executes it more than once, you can use reports to disable them. For more information, see List of Administration Tools [page 72].

### 13.1.1.1.3.3 Form Generation with Adobe Document Services

To gain comprehensive information about how to troubleshoot the form generation with Adobe Document Services, see SAP Note 944221.

### 13.1.1.1.4 Support Desk Management

If issues arise when using SAP software, you can get in contact with the SAP support desk.

For sending problem incidents for Product Compliance for Discrete Industries to SAP, choose the appropriate component name from the SAP component hierarchy.
13.1.1.2 Product Safety and Stewardship for Process Industries

This section contains information valid for:

- Basic Data and Tools
- Product Safety
- Global Label Management
- Dangerous Goods Management

13.1.1.2.1 Specific Monitoring Tools

Monitoring is essential to running and managing SAP technology. The following sections provide information about monitoring specifically for Product Safety and Stewardship for Process Industries. For more generic information, see Monitoring [page 8].

13.1.1.2.1.1 Component-Specific Monitoring

To monitor the availability of Windows Wordprocessor Integration servers (WWI servers) and Expert servers with CCMS, see SAP Note 1061242.

You can monitor the report shipping under Edit Report Shipping Orders (transaction CVD1). Under WWI Monitor (transaction CG5Z), you can monitor the report generation and the report shipping.

You can monitor the status of print requests that are generated in the SAP component Global Label Management in the Labeling Workbench (transaction CBGLWB).
13.1.1.2.1.2 Monitoring and Tools for Problem and Performance Analysis

Log and Trace Files

Use trace files and log files to analyze problems.

Table 36: Important Log and Trace Files for Report Shipping (EHS-SAF-RSH)

<table>
<thead>
<tr>
<th>Component</th>
<th>Content</th>
<th>File/Log Object</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>EHS-SAF-RSH</td>
<td>Logging Report Shipping</td>
<td>Log object CVDS</td>
<td>SAP Application Log (transaction SLG1)</td>
</tr>
</tbody>
</table>

Table 37: Important Log and Trace Files for Report Generation (EHS-BD-RDF)

<table>
<thead>
<tr>
<th>Component</th>
<th>Content</th>
<th>File/Log Object</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>EHS-BD-RDF</td>
<td>Logging Report Generation</td>
<td>Log object EHRE</td>
<td>SAP Application Log (transaction SLG1)</td>
</tr>
</tbody>
</table>

To log the report generation, set the environment parameter `REPORT_GENERATION_PROTOCOL` to `X` in the Customizing for Basic Data and Tools under Specify Environment Parameters.

Table 38: Important Log and Trace Files for Global Label Management (EHS-SAF-GLM)

<table>
<thead>
<tr>
<th>Component</th>
<th>Content</th>
<th>File/Log Object</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>EHS-SAF-GLM</td>
<td>Logging Global Label Management</td>
<td>Log object EHGL</td>
<td>SAP Application Log (transaction SLG1)</td>
</tr>
<tr>
<td>EHS-SAF-GLM</td>
<td>Logging print requests that are processed in Global Label Management</td>
<td>Log object EHPR</td>
<td>SAP Application Log (transaction SLG1)</td>
</tr>
</tbody>
</table>

Table 39: Important Log and Trace Files for Expert (EHS-BD-TLS-EXP)

<table>
<thead>
<tr>
<th>Component</th>
<th>Content</th>
<th>File/Log Object</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>EHS-BD-TLS-EXP</td>
<td>RFC log</td>
<td>Rfc*.log</td>
<td>Configured Expert log directory</td>
</tr>
<tr>
<td></td>
<td>RFC trace</td>
<td>Rfc*.trc</td>
<td>Expert installation directory</td>
</tr>
<tr>
<td></td>
<td>EXP log</td>
<td>Exp*.log</td>
<td>Configured Expert log directory</td>
</tr>
<tr>
<td></td>
<td>Windows Event Log</td>
<td>-</td>
<td>Windows Control Panel - Event Viewer</td>
</tr>
<tr>
<td></td>
<td>Dev_trc</td>
<td>dev_rfc.trc</td>
<td>Expert installation directory</td>
</tr>
<tr>
<td></td>
<td>Application Log</td>
<td>object EHAD</td>
<td>SAP Application Log (transaction SLG1)</td>
</tr>
</tbody>
</table>

For more information on Expert logs and traces and how to enable them, see SAP Note 1364100."
Table 40: Important Log and Trace files for WWI (EHS-BD-RDF-WWI)

<table>
<thead>
<tr>
<th>Component</th>
<th>Content</th>
<th>File/Log Object</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>EHS-BD-RDF-WWI</td>
<td>(1) Logging Report Generation</td>
<td>object EHAD</td>
<td>SAP Application Log (transaction SLG1)</td>
</tr>
<tr>
<td></td>
<td>(2) WWI err file Trace of one generation</td>
<td>*.err</td>
<td>WWI root directory</td>
</tr>
<tr>
<td></td>
<td>(3) Windows Event Log</td>
<td>-</td>
<td>Windows Control Panel - Event Viewer</td>
</tr>
<tr>
<td></td>
<td>(4) WWI file log</td>
<td>*.log</td>
<td>Windows temp directory</td>
</tr>
<tr>
<td></td>
<td>(5) RFC errors from RFC library</td>
<td>dev_rfc.trc</td>
<td>WWI installation directory</td>
</tr>
<tr>
<td></td>
<td>(6) RFC trace</td>
<td>Rfc*.trc</td>
<td>WWI installation directory</td>
</tr>
</tbody>
</table>

1. To log the report generation, set the environment parameter `REPORT_GENERATION_PROTOCOL` to `X` in Customizing for Basic Data and Tools under Specify Environment Parameters.

2. To save temporary WWI files including the err file, set `dont_delete` to `1` under `[spool]` in WWI.INI. Temporary WWI files are used for error analysis by SAP Support.

   The amount of disk space that is consumed by the temporary WWI files can increase rapidly. For this reason, set `dont_delete` to `0` to switch off this setting.

   For further information, see SAP Note 959195.

3. You can also check the recent generation logs in the Windows Event Log for each WWI service.

4. To enable the WWI file log, set `LogToFile` to `1` under `[Global]` in WWI.INI.

   The WWI file log is mainly used for long-term error analysis and to analyze crashes of WWI.

   **Caution**

   The logs can consume a lot of disc space. For this reason, the log to file will slow down the WWI server. For further information, see SAP Note 778684.

5. `dev_rfc.trc` is enabled through Remote Function Call (RFC) by default.

   `dev_rfc.trc` logs RFC connection errors.

6. To enable the RFC traces, set `RFC_TRACE` to `1` in the SAPRFC.INI file of the RFC destination.

   The RFC library logs the complete binary RFC traffic to the file.

   Note that the generated log files consume a lot of disc space. Therefore, set `RFC_TRACE` to `1` in the SAPRFC.INI file when not required.

The WWI logs depend on the trace level that has been configured for WWI. The WWI trace level is configured as parameter `-T` in the WWI service. Trace level ranges from `0` (only fatal errors) to `5` (debug trace) Trace level `3` is set as default.
**Workload Monitors**

Table 41: Monitor Details

<table>
<thead>
<tr>
<th>Component</th>
<th>Monitor</th>
<th>Description</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Wordprocessor Integration (for Product Safety)</td>
<td>WWI Monitor (transaction CG5Z)</td>
<td>Shows the queue of the report generation and report shipping orders in WWI.</td>
<td>You have configured the WWI generation in Customizing for Basic Data and Tools under Specify Generation Servers.</td>
</tr>
<tr>
<td>Windows Wordprocessor Integration (for print requests in EHS Global Label Management)</td>
<td>Labeling Workbench (transaction CBGLWB)</td>
<td>You can filter the print request queue by their states.</td>
<td>You have configured the processing of print request in Global Label Management.</td>
</tr>
</tbody>
</table>

Use the following filters in the *Labeling Workbench* to show the print requests in the respective status:

- Print requests bodies to be processes: status AA (Print request body exists)
- Print requests to be created: status ZS (Print request created, not yet processed)
- Print requests to be printed: status ZD (Print request ready for printing)

**Other Problem Analysis and Monitoring Tools**

Table 42: Monitor Tool Details

<table>
<thead>
<tr>
<th>Component</th>
<th>Monitor</th>
<th>Description</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Wordprocessor Integration and Expert</td>
<td>WWI and Expert Server Administration (transaction CGSADM)</td>
<td>Here, you can check the configuration and the Windows event log of WWI servers and Expert servers, furthermore you can switch on logging and download log files.</td>
<td>Management Servers are set up (see Customizing for Basic Data and Tools under Set Up Management Server).</td>
</tr>
</tbody>
</table>
| Windows Wordprocessor Integration (for Product Safety) | Job selection (transaction SM37) | Shows job logs | Use filter the following filters:  
- Job Name: **WWI**  
- User Name: *  
- and after event: * |
| Windows Wordprocessor Integration (for print requests in Global Label Management) | Job selection (transaction SM37) | Shows job logs | Use filter the following filters:  
- Job Name: **EHSGLM_PRQ**  
- User Name: *  
- and after event: * |
Interface Monitors

Table 43: Interface Details

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
<th>Technology Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>REPMAS</td>
<td>Reports are distributed from the product safety system to logistics systems.</td>
<td>IDoc</td>
</tr>
<tr>
<td>SUBMAS</td>
<td>Specification data is distributed from the product safety system to logistics systems.</td>
<td>IDoc</td>
</tr>
<tr>
<td>PHRMAS</td>
<td>Phrase data is distributed from the product safety system to logistics systems.</td>
<td>IDoc</td>
</tr>
<tr>
<td>DANGEROUSGOOD</td>
<td>Dangerous goods data is distributed from the product safety system to logistics systems.</td>
<td>IDoc</td>
</tr>
<tr>
<td>WWI*</td>
<td>There are several RFC functions (WWI*) which call the WWI server.</td>
<td>RFC</td>
</tr>
<tr>
<td>START_EXPERT_SYSTEM</td>
<td>Calls the Expert rules engine.</td>
<td>RFC</td>
</tr>
<tr>
<td>RMS_SOLVE_RXM</td>
<td>Calls the Expert matrix solver.</td>
<td>RFC</td>
</tr>
</tbody>
</table>

Data Growth and Data Archiving Monitors

Most critical regarding database growth are reports as they consume considerable disc space. The documents are saved in the Document Management System (DMS). If you do not use an external DMS system, data base table DRAO increases in size and consumes considerable space.

To reduce the consumed database space, see SAP Note 586293.

To use data archiving see SAP Notes 915854 and 1093408.

To reduce database space consumed by specification data run report RC1PHDEL regularly. Specification data is not deleted by default but marked for deletion. Run report RC1PHDEL to delete the data on the database physically.

Note
Consider the applicable data retention policies.

You can define periodic tasks required to contain data growth (that is, to reorganize temporary data).

Data Consistency

If you store related or identical data in different locations, this can cause data inconsistencies, for example, after restoring a single component (such as Windows Wordprocessor Integration or Expert). The following table describes how you can verify data consistency and how you can repair data inconsistencies.
Table 44

<table>
<thead>
<tr>
<th>Component / Data Store</th>
<th>Check Tool / Method</th>
<th>Description</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>WWI Print Request Cache</td>
<td>Delete cache</td>
<td>Delete the DMS folder on the WWI server. WWI will refill this cache.</td>
<td>You have configured the Customizing activity Configure WWI Document Management System.</td>
</tr>
</tbody>
</table>

### 13.1.1.2.2 Specific Management Tools

SAP provides you with infrastructure to help your technical support consultants and system administrators effectively manage all SAP components and complete all tasks related to technical administration and operation. The following sections provide information about managing *Product Safety and Stewardship for Process Industries*. For more generic information, see *Management of SAP S/4HANA* [page 10].

### 13.1.1.2.2.1 Starting and Stopping

Table 45: Start and Stop Tools

<table>
<thead>
<tr>
<th>Software Component</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Wordprocessor Integration (WWI)</td>
<td>Windows Services</td>
<td>Start the watchdog service that is used for WWI (EhsStart or EhsManagementServer).</td>
</tr>
<tr>
<td>Expert</td>
<td>Windows Services</td>
<td>Start the watchdog service that is used for Expert (EhsStart or EhsManagementServer).</td>
</tr>
</tbody>
</table>

### 13.1.1.2.2.2 Software Configuration

This chapter explains the configurable components or scenarios that are used by *Product Safety and Stewardship for Process Industries* and the tools that are used to configure the settings.

Table 46: Component Configuration Tools

<table>
<thead>
<tr>
<th>Component</th>
<th>Configuration Tool(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Wordprocessor Integration (WWI) and Expert</td>
<td>Transaction CGSADM</td>
<td>Offers the most commonly used administration and configuration options that are necessary for WWI and Expert.</td>
</tr>
<tr>
<td>Component</td>
<td>Configuration Tool(s)</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Windows Wordprocessor Integration (WWI) and Expert</td>
<td>SvcAdmin.Exe</td>
<td>Tool to change the Windows service settings.</td>
</tr>
<tr>
<td>Windows Wordprocessor Integration (WWI) and Expert</td>
<td>Saprfc.ini</td>
<td>Used to configure the RFC destinations.</td>
</tr>
<tr>
<td>Windows Wordprocessor Integration (WWI)</td>
<td>WWI.INI</td>
<td>Used to configure WWI.</td>
</tr>
<tr>
<td>Windows Wordprocessor Integration (WWI)</td>
<td>ConPro.Exe</td>
<td>WWI configuration program that guides the installation steps you have to proceed manually and that checks the consistency of the configuration.</td>
</tr>
</tbody>
</table>

### 13.1.1.2.2.3 Administration Tools

Table 47: List of Tools

<table>
<thead>
<tr>
<th>Software Component</th>
<th>Transaction / Tool</th>
<th>Description</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Wordprocessor Integration (WWI) and Expert</td>
<td>WWI and Expert Server Administration (transaction CGSADM)</td>
<td>Offers the most commonly used administration and configuration options that are necessary to implement WWI and Expert.</td>
<td></td>
</tr>
<tr>
<td>Windows Wordprocessor Integration (WWI) and Expert</td>
<td>SvcAdmin.Exe</td>
<td>Used to change the Windows service settings.</td>
<td></td>
</tr>
<tr>
<td>Windows Wordprocessor Integration (WWI)</td>
<td>WWI.INI</td>
<td>Used to configure WWI, including the log files.</td>
<td></td>
</tr>
<tr>
<td>Expert</td>
<td>ExpAdmin.Exe</td>
<td>Used to configure the Expert rule sets and the Expert settings including the trace levels.</td>
<td></td>
</tr>
</tbody>
</table>
13.1.1.2.2.4 Periodic Tasks

Table 48: Scheduled Periodic Tasks for Windows Wordprocessor Integration (WWI) and Expert

<table>
<thead>
<tr>
<th>Program Name / Task</th>
<th>Task Scheduling Tool</th>
<th>Recommended Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Update</td>
<td>Windows Update</td>
<td>1 / month</td>
<td>Install the Microsoft security updates on the WWI servers and Expert servers</td>
</tr>
</tbody>
</table>

Table 49: Manual Tasks for Windows Wordprocessor Integration (WWI) and Expert

<table>
<thead>
<tr>
<th>Task</th>
<th>Tool(s) Supporting this Task</th>
<th>Recommended Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean up logs and traces</td>
<td></td>
<td>1 / week</td>
<td>For Expert and WWI clean up the log and trace files as well as temporary WWI files. See Trace and Log Files.</td>
</tr>
</tbody>
</table>

13.1.1.2.2.5 Load Balancing

You can determine load balancing from Product Safety and Stewardship for Process Industries to Expert servers and WWI servers through Remote Function Call (RFC).

For more information see SAP Note 1061242.

Table 50: Logging On and Load Balancing Setup / Tools

<table>
<thead>
<tr>
<th>Scenario(s)</th>
<th>Description</th>
<th>Tools to be Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expert</td>
<td>Connect several Expert services to one RFC destination. RFC applies the load balancing automatically.</td>
<td>RFC</td>
</tr>
<tr>
<td>WWI</td>
<td>If you use several WWI servers on several RFC destinations, the load balancing is determined by the WWI dispatcher background job.</td>
<td>Customizing</td>
</tr>
<tr>
<td>WWI for Global Label Management</td>
<td>If you connect several WWI services to one RFC destination, RFC applies the load balancing automatically.</td>
<td>RFC</td>
</tr>
<tr>
<td>WWI for print request processing in Global Label Management</td>
<td>If you connect several WWI services to each RFC destination, RFC applies the load balancing automatically. The load is distributed through several decentralized WWI servers.</td>
<td>RFC Customizing</td>
</tr>
</tbody>
</table>
13.1.1.2.6 Management of Outdated Technical Data

For Expert and Windows Wordprocessor Integration (WWI), you must clean up the log and trace files as well as temporary WWI files. For more information, see the section Log and Trace Files in Monitoring and Tools for Problem and Performance Analysis [page 79].

13.1.1.2.3 High Availability

Product Safety and Stewardship for Process Industries follows the general high availability (HA) concept for all SAP NetWeaver based systems. For more information, see Business Continuity and High Availability [page 15].

Table 51: HA Setup

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>HA Setup Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Wordprocessor Integration (WWI)</td>
<td>Creation and printing of reports</td>
<td>See SAP Note 1061242</td>
</tr>
<tr>
<td>Expert</td>
<td>Calculation of secondary specification data</td>
<td></td>
</tr>
</tbody>
</table>

Each of the above components can be a single point of failure in this scenario. In order to achieve high availability (HA) for the complete scenario, it is required that all components with single point of failures are setup with HA.

13.1.1.2.4 Specific Troubleshooting

For more information on troubleshooting Expert, see SAP Note 1364100.
For more information on troubleshooting Windows Wordprocessor Integration (WWI), see SAP Note 1058521.

13.1.1.2.5 Support Desk Management

If issues arise when using SAP software, you can get in contact with the SAP support desk. For general information about SAP support, see Support Desk Management [page 19].
For sending problem messages/tickets for Product Safety and Stewardship for Process Industries to SAP, choose the appropriate component (or subcomponent) name from the SAP component hierarchy.

Remote Support Setup

To analyze Windows Wordprocessor Integration (WWI) and Expert issues you must set up a remote connection to the underlying Windows servers, for example, by Windows Terminal Services (WTS).

See SAP Note 35010 for setting up remote connections.
Problem Message Handover

Use the appropriate sub-component of Product Safety and Stewardship.
14 Business Network Integration

SAP S/4HANA currently supports integration scenarios with the Ariba Network and with SAP Fieldglass.

14.1 Monitoring Business Network Integration: Overview

To monitor the integration of SAP S/4HANA with a business network, you have the following options, depending on your connectivity type:

- Output Management (only for outbound messages)
- Web Services Monitor (transaction SRT_MONI) - only for direct connectivity and connectivity via HANA Cloud Integration (HCI)
- Integration Engine: Monitor (transaction SXMB_MONI) - only for mediated connectivity via Process Integration (PI), therefore only available for the Ariba Network
- Application Interface Framework (AIF) - (optional component)

In addition, the application log (transaction SLG1) records the message exchange between SAP S/4HANA and the business network.

For error handling, you can use Forward Error Handling (FEH).

14.1.1 Monitoring of cXML Messages

Output Management (Only for Outbound Messages)

In the output management, you can monitor as well as cancel or resend messages for which the transfer to the Ariba Network has failed or has been performed with errors.

Starting point is the application itself, where you can display the output status and the output processing log. For example, in the Manage Purchase Orders app under Output Items, you can click Open Action Menu Show Application Log. This takes you to the Log Details, where you can display the XML message ID. You can use this ID to find specific messages in various monitoring tools.

Web Service Monitor - (for Direct Connectivity and Connectivity via HCI)

In the Web Service Monitor (transaction SRT_MONI), you can monitor both inbound and outbound cXML messages. To monitor the messages exchanged with the business network, you have to filter for cXML messages.

You do this on the Standard Selection tab: Under Sender Information and under Receiver Information, enter cXML* in the Interface Name field.

To cancel or restart messages for which an error has occurred in the transfer, you can use the Actions button.

You can use the report Send Status Update for Canceled Inbound Messages (ARBFND_SEND_STATUS_CANCELLED) to discard messages: The report selects messages that you have canceled.
manually in transaction sxmb_moni (*Integration Engine: Monitor*) and transfers the *Failed* status to the business network.

**Integration Engine: Monitoring (Only for Ariba Network Using Mediated Connectivity)**

In *Integration Engine: Monitoring* (transaction SXMB_MONI), you can monitor both inbound and outbound cXML messages. Double-click *Monitor for Processed XML Messages*. To filter for messages exchanged with the business network, you have the following options:

- On the *Standard Selection Criteria* tab, under *Sender Information* and under *Receiver Information*, enter `cXML*` in the *Interface Name* field.

**Informing the Ariba Network About Discarded Messages**

If you do not use Forward Error Handling or SAP Application Interface Framework (AIF), you can use the report *Send Status Update for Canceled Inbound Messages* (ARBFND_SEND_STATUS_CANCELLED) to inform your suppliers on the Ariba Network about discarded messages: The report selects messages that you have canceled manually in the *Web Service Monitor* (transaction SRT_MONI) or in transaction the *Integration Engine: Monitor* (transaction sxmb_moni) and transfers the *Failed* status to the Ariba Network.

**SAP Application Interface Framework (AIF)**

You can use the SAP Application Interface Framework (AIF) to monitor cXML messages and perform related troubleshooting activities. AIF enables you to monitor different mechanisms for data exchange, such as XML, IDOC, etc.

In AIF, you can monitor the following cXML messages:

- All inbound cXML messages that are received in SAP S/4HANA.
- All outbound messages that are sent via direct connectivity or via HANA Cloud Integration (HCI).

For outbound messages that are sent via mediated connectivity, you have to use the monitoring tools provided by the middleware.

To display cXML messages in transaction *Monitor and Error Handling* (/AIF/ERR), you have to specify a namespace, for example the default namespace /BNAR.B.

In the *Monitor and Error Handling* transaction, you can do the following:

- Restart messages that were transmitted with errors.
- Edit the message payload.
- Display the same information as in the *Application Log* (transaction SLG1).
- Cancel messages.

If you cancel inbound messages, the "Failed" status is transferred to the business network, informing the business partner about the cancellation of the message.
More Information

For more information about AIF, see:

- The sections about the SAP Application Interface Framework in this guide
- The user assistance for the SAP Application Interface Framework in SAP S/4HANA. It is available on SAP Help Portal at help.sap.com/erp.

14.1.2 Application Log

The application log (transaction SLG1) records all messages sent to or received from the Ariba Network or SAP Fieldglass. The log entries are listed under the CXML_INTEGRATION object. Note that log entries created in releases earlier than SAP S/4HANA 1610 can be found under the log object ARIBA_INTEGRATION.

There are four subobjects for further filtering:

- **INBOUND**
  
  The SAP S/4HANA system processes all messages belonging to the namespace http://sap.com/XI/ARBFND1 and the below defined interfaces. Corresponding entries are written to the application log. You can review the processing status of the entries. Note:
  
  - Messages that have been pushed into the SAP S/4HANA system by middleware create an entry only with the subobject INBOUND.
  - Messages that have been polled from a business network directly or via HCI into SAP S/4HANA have entries both under the INBOUND and the POLLING subobjects.

- **POLLING**

  If you run the integration with the business network through direct connectivity or via HCI, you must schedule a polling job, also known as Polling Agent, to retrieve messages. Each time the polling job runs, it writes an entry in the application log, listing the message type and timestamp when the system has polled.

  After messages have been polled from the business network, the log entry lists all message IDs (XML ID and payload ID) that have been retrieved and put in the queue for message processing.

  For more information about the polling jobs, see the documentation available in Customizing for Business Network Integration under the following paths:

  - Integration with the Ariba Network ➤ Framework Settings ➤ Direct Connectivity Settings ➤ Schedule Polling Agent
  - Integration with SAP Fieldglass ➤ Framework Settings ➤ Direct Connectivity Settings ➤ Schedule Polling Agent

- **OUTBOUND**

  Every message leaving the SAP S/4HANA system writes an entry to the application log with the subtype OUTBOUND. For direct connectivity and HCI, there are two entries:

  - An entry for the creation of the cXML message
  - An entry indicating whether the message has been transferred to the business network successfully.
Search in the Application Log

For inbound and outbound messages you can filter the application log entries by object and subobject as described above. To search for specific entries, you can enter a business object ID, a payload ID, or a XML message ID - preceded and followed by an asterisk (*) - in the External ID field.

Since many entries are created in the application log to record the message exchange with business networks, we recommend that you optimize your settings for archiving your application log. For more information, search for the phrase “Application Log – User Guidelines (BC-SRV-BAL)” in the documentation of SAP NetWeaver at http://help.sap.com.

14.1.3 Forward Error Handling

You can use Forward Error Handling (FEH) to monitor errors and to perform related troubleshooting activities. In FEH, you can monitor errors that have occurred during transfer of the following cXML messages:

- All inbound messages that have been received in SAP S/4HANA.
- All outbound messages that have been sent via direct connectivity or via HANA Cloud Integration (HCI).

For outbound messages that are sent via mediated connectivity, you have to use the monitoring tools provided by the middleware.

Prerequisites

To use FEH, you have to define a resolution strategy that specifies whether and how processes are executed again or ended after errors or conflicts occur. You can define, for example, the periods during which a certain error can be corrected by automatically repeating the process. For more information, see Customizing for Cross-Application Components under Processes and Tools for Enterprise Applications › Enterprise Services › Error and Conflict Handler › Define Resolution Strategy. For business network integration, the component BNS-ARI-SE-FND is available for which you create the resolution strategy.

Postprocessing Desktop

A postprocessing order is created in FEH when there is an error in either inbound or outbound processing. Use Error and Conflict Handler: Process Postprocessing Orders (transaction ECH_MONI_SEL) to analyze the error.

The following table provides an overview of the business objects and the corresponding cXML messages for which errors may occur. Note that the “business objects” in the sense of FEH correspond to cXML message types.

<table>
<thead>
<tr>
<th>“Business object”, also referred to as “Business Process” in FEH</th>
<th>cXML Message Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARBFNDOADP</td>
<td>This object is used for error handling of all outbound cXML message types.</td>
</tr>
<tr>
<td>ARBFNDCONF</td>
<td>ConfirmationRequest</td>
</tr>
</tbody>
</table>
“Business object”, also referred to as “Business Process” in FEH | cXML Message Type
--- | ---
ARBFNDSHIP | ShipNoticeRequest
ARBFNDINVCS | InvoiceDetailRequest
ARBFNDSRVE | ServiceEntryRequest
ARBFNDCCPAYP | CopyRequestPaymentProposalRequest
ARBFNDQTEM | QuoteMessage

**Postprocessing Desktop: Edit Order**

For troubleshooting, double-click a postprocessing order to edit the details. In the *Postprocessing Desktop – Edit Order: Details* screen you can perform the following actions to resolve the error:

- **Repeat**
  The Repeat action restarts the processing of the cXML message. This is usually done after you have resolved an error. For example, you may have changed the business object or the payload, or a temporary system issue has been resolved.

- **Display or change payload**
  To resolve an error, it may be necessary that you change the payload of a cXML message. You can make the required authorization settings in Customizing for Cross-Application Components under [General Application Functions → Error and Conflict Handler → Authorization for Payload Editor](#).

  Use the Details icon in the message table to navigate from the Postprocessing Desktop to the application log, where you can display further information.

- **Confirm**
  The Confirm action changes the order status in the Postprocessing Office to Completed. You normally use this option if an inbound cXML message could not be transferred and you have applied the changes to the business document manually.

- **Discard**
  The Discard action changes the order status in the Postprocessing Office to Completed and sends a StatusUpdateRequest cXML message to the Ariba Network to set the acknowledgement status of the corresponding Ariba document to Failed.
## Typographic Conventions

### Table 53

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;Example&gt;</code></td>
<td>Angle brackets indicate that you replace these words or characters with appropriate entries to make entries in the system, for example, “Enter your <code>&lt;User Name&gt;</code>”.</td>
</tr>
<tr>
<td>Example ➔ Example</td>
<td>Arrows separating the parts of a navigation path, for example, menu options</td>
</tr>
<tr>
<td>Example</td>
<td>Emphasized words or expressions</td>
</tr>
<tr>
<td><a href="http://www.sap.com">www.sap.com</a></td>
<td>Textual cross-references to an internet address</td>
</tr>
<tr>
<td>/example</td>
<td>Quicklinks added to the internet address of a homepage to enable quick access to specific content on the Web</td>
</tr>
<tr>
<td>123456</td>
<td>Hyperlink to an SAP Note, for example, SAP Note 123456</td>
</tr>
<tr>
<td>Example</td>
<td>• Words or characters quoted from the screen. These include field labels, screen titles, pushbutton labels, menu names, and menu options. • Cross-references to other documentation or published works</td>
</tr>
<tr>
<td>Example</td>
<td>• Output on the screen following a user action, for example, messages • Source code or syntax quoted directly from a program • File and directory names and their paths, names of variables and parameters, and names of installation, upgrade, and database tools</td>
</tr>
<tr>
<td>EXAMPLE</td>
<td>Technical names of system objects. These include report names, program names, transaction codes, database table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE</td>
</tr>
<tr>
<td>EXAMPLE</td>
<td>Keys on the keyboard</td>
</tr>
</tbody>
</table>